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PREFACE 

This document describes the installation and operation of TASC Systems’ 
siteVIEW Enterprise 2.1, siteVIEW v2.0 and siteVIEW scope 2.0 distributed 
monitoring software applications. 

Hardware and software described in this document is subject to ongoing 
development and improvement. Consequently there may be minor 
discrepancies between the information in this document and the performance 
and design of the hardware and software. 

The siteVIEW 2.1 system is designed for flexibility of use and installation and 
is therefore highly configurable and should only be installed by an 
appropriately trained technician. 

The user should ascertain that this product is suitable for the intended 
application. TASC Systems Inc. accepts no responsibility, liability, for misuse, 
or damage resulting from the inappropriate use of the product described 
herein. 

Before connecting any equipment to siteVIEW 2.1, it is advised to read this 
manual in its entirety. 

 



TASC siteVIEW 2.1 User Manual 050-015-0050 R07 

TASC Systems Inc. All Rights Reserved Page 4 of 175 

TABLE OF CONTENTS 

PREFACE ............................................................................................................................ 3 

INDEX OF FIGURES ............................................................................................................ 8 

INDEX OF TABLES ........................................................................................................... 10 

RELATED DOCUMENTS ................................................................................................... 11 

REVISION HISTORY .......................................................................................................... 12 

1. PRODUCT DESCRIPTION .......................................................................................... 13 

1.1. GENERAL DESCRIPTION ................................................................................................................ 13 
1.2. INSTALLATION REQUIREMENTS ............................................................................................................. 13 

1.2.1. Data Handler Requirements ............................................................................................ 13 
1.2.2. Communication Service Requirements ........................................................................... 13 
1.2.3. Alarm Notification Handler Requirements ....................................................................... 14 
1.2.4. User Interface Requirements .......................................................................................... 14 

1.3. SITEVIEW KEY FEATURES .................................................................................................................... 14 

2. INTRODUCTION .......................................................................................................... 15 

2.1. N-TIER SOFTWARE ARCHITECTURE....................................................................................................... 15 
2.2. SITEVIEW 2.1 LICENSING ..................................................................................................................... 16 

2.2.1. The Security Key ............................................................................................................. 16 
2.2.2. Feature Add-Ons/Options ............................................................................................... 17 
2.2.3. Comparison of TASC siteVIEW 2.1 Products ................................................................. 18 

3. SOFTWARE CONFIGURATION .................................................................................. 19 

3.1. INSTALLING THE SYSTEM ...................................................................................................................... 19 
3.1.1. Distributed Installations of siteVIEW Components .......................................................... 19 

3.2. CONFIGURING THE DATA HANDLER ....................................................................................................... 20 
3.3. CONFIGURING THE COMMUNICATION SERVICE ....................................................................................... 22 
3.4. CONFIGURING THE ALARM NOTIFICATION HANDLER............................................................................... 23 
3.5. STARTING THE USER INTERFACE ........................................................................................................... 24 

3.5.1. Logging In to siteVIEW .................................................................................................... 24 
3.5.2. Password Recovery ........................................................................................................ 26 

3.6. REDUNDANT DATA HANDLER ................................................................................................................ 26 
3.6.1. Configuration ................................................................................................................... 26 

4. THE GRAPHICAL USER INTERFACE ........................................................................ 29 

4.1. SITE NAVIGATION TREE ........................................................................................................................ 30 
4.2. MAIN MENU.......................................................................................................................................... 30 
4.3. TOOL BAR ........................................................................................................................................... 31 
4.4. ALARM PANEL ..................................................................................................................................... 31 
4.5. SITE PANEL ......................................................................................................................................... 32 
4.6. PANEL COMPONENTS ........................................................................................................................... 34 
4.7. STATUS BAR ........................................................................................................................................ 34 
4.8. COMMUNICATION PANEL ....................................................................................................................... 34 
4.9. BANDWIDTH METER.............................................................................................................................. 36 

5. USER ADMINISTRATION ............................................................................................ 37 



TASC siteVIEW 2.1 User Manual 050-015-0050 R07 

TASC Systems Inc. All Rights Reserved Page 5 of 175 

5.1. MANAGING USER ACCOUNTS ................................................................................................................ 37 
5.1.1. Changing An Account Password ..................................................................................... 38 
5.1.2. Forced User Sign Out...................................................................................................... 38 

6. SYSTEM CONFIGURATION ........................................................................................ 40 

6.1. THE COMMUNICATION SERVICE ............................................................................................................. 40 
6.2. COMMUNICATION PORTS ...................................................................................................................... 41 

6.2.1. Adding A New Communication Port ................................................................................ 41 
6.2.2. Configuring an Existing Communication Port ................................................................. 44 

6.3. DEVICES .............................................................................................................................................. 46 
6.3.1. Adding a New Device ...................................................................................................... 46 
6.3.2. Device Details ................................................................................................................. 48 
6.3.3. Ping Devices ................................................................................................................... 51 

6.4. SITE PANEL ......................................................................................................................................... 52 
6.4.1. Background Properties .................................................................................................... 52 
6.4.2. Panel Control Property Form .......................................................................................... 53 
6.4.3. Panel Control Types ........................................................................................................ 55 
6.4.4. Format String ................................................................................................................... 63 
6.4.5. Adding Controls to a Panel ............................................................................................. 65 
6.4.6. Panel Import and Export ................................................................................................. 67 

6.5. ALARM CONDITIONS ............................................................................................................................. 67 
6.5.1. Alarm Condition States.................................................................................................... 67 
6.5.2. Configuring an Alarm Condition ...................................................................................... 68 
6.5.2.1. Analog and Temperature Sensor Alarm Conditions ....................................................... 70 
6.5.1. Alarm Management ......................................................................................................... 70 
6.5.1.1. Show Cleared Alarms...................................................................................................... 70 
6.5.1.2. Clear All Reported Alarms ............................................................................................... 71 
6.5.1.3. Clear a Selected Alarm ................................................................................................... 71 
6.5.1.4. Acknowledge a Selected Alarm ...................................................................................... 72 
6.5.1.5. Clear All Alarms for a Device .......................................................................................... 72 
6.5.1.6. Clear All Ceased Alarms ................................................................................................. 73 
6.5.2. Alarm Specific Reporting Options ................................................................................... 73 
6.5.3. Global Alarm Notification Settings ................................................................................... 76 

6.6. AUTOMATED POLLING .......................................................................................................................... 82 
6.7. SITE MAPPING ...................................................................................................................................... 83 
6.8. USER ACCESS ..................................................................................................................................... 85 

7. MONITORING AND CONTROLING DEVICES ............................................................ 86 

7.1. DEVICE INPUTS AND OUTPUTS .............................................................................................................. 86 
7.2. ALARM HANDLING ................................................................................................................................ 87 
7.3. MANUALLY POLLING THE DEVICES IN THE NETWORK ............................................................................. 89 

8. LOGGING ..................................................................................................................... 91 

8.1. SITEVIEW LOGGING ............................................................................................................................. 92 
8.2. DEVICE LOGGING ................................................................................................................................. 92 
8.3. LOG VIEWER PROPERTIES .................................................................................................................... 93 

8.3.1. Log Archiving ................................................................................................................... 93 

9. SYSTEM ARCHIVE AND RESTORE ........................................................................... 95 

9.1. AUTOMATED ARCHIVE .......................................................................................................................... 95 
9.2. MANUAL ARCHIVE & RESTORE ............................................................................................................. 95 

10. TROUBLESHOOTING ................................................................................................. 97 

10.1. EVENT VIEWER ..................................................................................................................................... 97 



TASC siteVIEW 2.1 User Manual 050-015-0050 R07 

TASC Systems Inc. All Rights Reserved Page 6 of 175 

10.2. COMMUNICATION SERVICE LOG FILES ................................................................................................... 97 
10.2.1. Message Transaction Log Files ...................................................................................... 97 
10.2.1. Port Transactions Log Files ............................................................................................ 98 

10.3. SOLUTIONS TO PROBLEMS.................................................................................................................... 99 

APPENDIX A. TASC HARDWARE & FIRMWARE ....................................................... 101 

A.1. OVERVIEW ......................................................................................................................................... 101 
A.2. CONFIGURATION UTILITIES ................................................................................................................. 101 
A.3. ANALOG INPUTS ................................................................................................................................. 101 

A.3.1. Jumper Configuration ...................................................................................................... 101 
A 3.2.User Ranges ..................................................................................................................... 103 

APPENDIX B. TASC SITECOMMANDER CONFIGURATION ...................................... 104 

B.1. DESCRIPTION ..................................................................................................................................... 104 
B.2. GENERAL ........................................................................................................................................... 105 
B.3. STARTUP OPTIONS ............................................................................................................................. 106 
B.4. COMMUNICATION ................................................................................................................................ 106 
B.5. CONTACT INPUTS ............................................................................................................................... 108 
B.6. ANALOG INPUTS ................................................................................................................................. 109 
B.7. TEMPERATURE INPUTS ....................................................................................................................... 110 
B.8. OUTPUTS ........................................................................................................................................... 111 
B.9. DEVICE LOGGING – CONFIGURATION ................................................................................................... 112 
B.10. DEVICE LOGGING – DOWNLOADING TO SITEVIEW ............................................................................... 113 

APPENDIX C. TASC SITEPORTAL LITE CONFIGURATION ...................................... 116 

C.1. DESCRIPTION ..................................................................................................................................... 116 
C.2. GENERAL ........................................................................................................................................... 117 
C.3. CALL & MODEM CONTROL .................................................................................................................. 117 

C.3.1. Call Control ...................................................................................................................... 117 
C.3.2. Device Modem Parameters ............................................................................................. 118 

C.4. CONTACT INPUTS ............................................................................................................................... 119 
C.5. ANALOG INPUTS ................................................................................................................................. 120 
C.6. TEMPERATURE INPUTS ....................................................................................................................... 122 
C.7. OUTPUTS ........................................................................................................................................... 123 
C.8. SITE INFORMATION ............................................................................................................................. 124 
C.9. PERIPHERALS .................................................................................................................................... 125 
C.10. PERIPHERAL PASSTHROUGH IN SITEVIEW .......................................................................................... 125 

APPENDIX D. TASC SITERSM CONFIGURATION ...................................................... 128 

D.1. DESCRIPTION ..................................................................................................................................... 129 
D.2. GENERAL ........................................................................................................................................... 129 
D.3. COMMUNICATION SETTINGS ................................................................................................................ 130 
D.4. CONTACT INPUTS ............................................................................................................................... 131 
D.5. ANALOG INPUTS ................................................................................................................................. 131 
D.6. TEMPERATURE INPUTS ....................................................................................................................... 134 
D.7. OUTPUTS ........................................................................................................................................... 135 

APPENDIX E. PING DEVICE CONFIGURATION ......................................................... 136 

E.1. ADDING PING DEVICES ....................................................................................................................... 136 
E.2. USING PING DEVICES ......................................................................................................................... 137 

E.2.1. Understanding Ping Transactions ................................................................................. 137 
E.2.2. Generating Ping Transactions ....................................................................................... 137 
E.2.3. Monitoring Ping Devices Transactions .......................................................................... 138 
E.2.4. Reviewing Ping Device Transactions ............................................................................ 138 



TASC siteVIEW 2.1 User Manual 050-015-0050 R07 

TASC Systems Inc. All Rights Reserved Page 7 of 175 

APPENDIX F. SITEVIEW TO DEVICE COMMUNICATIONS ........................................ 140 

F.1. SITEVIEW TO SITERSM COMMUNICATION MANAGEMENT..................................................................... 140 
F.1.1. Overview .......................................................................................................................... 140 
F.1.2. Selecting TASC Serial, CPR Serial and Ethernet Devices .............................................. 140 
F.1.3. Differences between TASC Serial, CPR Serial and IP Devices ...................................... 142 
F.1.4. Communication Alarms .................................................................................................... 143 
F.1.5. Communication Logging System ..................................................................................... 144 
F.1.6. Communication State Icons ............................................................................................. 146 

F.2. SITEVIEW COMMUNICATION VIA LANTRONIX CPR PORTS .................................................................... 148 
F.2.1. Lantronix CPR Overview ................................................................................................. 148 
F.2.2. siteRSM Tunnel Settings ................................................................................................. 150 
F.2.3. Lantronix CPR Settings.................................................................................................... 152 

F.3. SITEVIEW COMMUNICATION VIA ETHERNET PORTS ............................................................................. 153 
F.3.1. Adding Ethernet Devices ................................................................................................. 153 
F.3.2. Using Ethernet Devices ................................................................................................... 154 
F.3.2.1. Understanding Ethernet Device Transactions .............................................................. 154 
F.3.2.2. Generating IP Device Transactions .............................................................................. 154 
F.3.2.3. Monitoring TASC Ethernet Device Transactions .......................................................... 155 
F.3.2.4. Reviewing Ethernet Device Transactions ..................................................................... 155 

F.4. MIGRATING TASC SERIAL OR CPR SERIAL DEVICES TO ETHERNET DEVICES ...................................... 156 
F.4.1. Adjusting siteRSM IP Settings ...................................................................................... 156 
F.4.2. Creating the IP Device .................................................................................................. 161 
F.4.3. Migrating siteVIEW-specific Data .................................................................................. 162 
F.4.4. Testing and Finalizing Migration ................................................................................... 164 

APPENDIX G. SITEVIEW PANEL DESIGN .................................................................. 165 

G.1. PANEL DESIGN GUIDELINES ................................................................................................................ 165 
G.1.1. Panel Image Size .......................................................................................................... 165 
G.1.2. Panel Image Layout ...................................................................................................... 166 
G.1.3. Panel Sub-Groups ......................................................................................................... 166 
G.1.4. HMI Standards .............................................................................................................. 167 
G.1.5. Panel Image Design Tools ............................................................................................ 168 

G.2. PANEL ICONS ..................................................................................................................................... 169 
G.2.1. Icon Usage .................................................................................................................... 169 
G.2.2. Icon Design Tools .......................................................................................................... 169 

G.3. SITEVIEW CONTROL GUIDELINES ....................................................................................................... 170 
G.3.1. siteVIEW Control Usage ............................................................................................... 170 
G.3.2. Contact Input Controls................................................................................................... 171 
G.3.3. Contact Outputs Controls .............................................................................................. 171 
G.3.4. Analog Input Controls .................................................................................................... 171 
G.3.5. Temperature Controls ................................................................................................... 171 

G.4. STANDARD SITEVIEW ICON SETS ....................................................................................................... 172 

APPENDIX H. SITEVIEW ADMINISTRATION .............................................................. 173 

H.1. SITEVIEW DEPLOYMENT .................................................................................................................... 173 
H.1.1. Device Planning ............................................................................................................ 173 
H.1.2. System Communication/Network Design ...................................................................... 173 
H.1.3. siteVIEW User Interface Design .................................................................................... 173 
H.1.4. siteVIEW I/O Properties Refinement ............................................................................. 174 
H.1.5. siteVIEW User Account Management ........................................................................... 174 
H.1.6. siteVIEW Notification and Alarming Definition .............................................................. 174 
H.1.7. siteVIEW Communication Optimization ........................................................................ 174 
H.1.8. Operational Preparedness ............................................................................................ 174 



TASC siteVIEW 2.1 User Manual 050-015-0050 R07 

TASC Systems Inc. All Rights Reserved Page 8 of 175 

INDEX OF FIGURES 

Figure 1 – siteVIEW Software Component Architecture............................................................................. 15 
Figure 2 – Data Handler Utility – Configuration Tab ................................................................................... 20 
Figure 3 – Data Handler Utility – Activity Tab .............................................................................................. 21 
Figure 4 – Communication Service Configuration Tool ............................................................................. 22 
Figure 5 – Alarm Notification Handler Configuration Tool ......................................................................... 23 
Figure 6 – siteVIEW 2.1 User Interface Desktop Shortcut Icon ................................................................. 24 
Figure 7 - User Interface - Sign In ................................................................................................................. 24 
Figure 8 - User Interface - Not Connected to Data Handler ........................................................................ 25 
Figure 9 – Data Handler Connection Form .................................................................................................. 25 
Figure 10 – Redundant Data Handler Configuration Utility ........................................................................ 27 
Figure 11 – Redundant Data Handler Status ............................................................................................... 28 
Figure 12 – Connected to Redundant Data Handler ................................................................................... 28 
Figure 13 - siteVIEW User Interface .............................................................................................................. 29 
Figure 14 - Toolbar Buttons ........................................................................................................................... 31 
Figure 15 - Alarm Panel Components........................................................................................................... 31 
Figure 16 – Site Panel .................................................................................................................................... 33 
Figure 17 - Status Bar Components ............................................................................................................. 34 
Figure 18 - Communication Panel ................................................................................................................. 35 
Figure 19 - Outputs Update Communication ............................................................................................... 35 
Figure 20 – Bandwidth Meter ......................................................................................................................... 36 
Figure 21 - User Administration .................................................................................................................... 37 
Figure 22 - Changing Your Password ........................................................................................................... 38 
Figure 23 - User Sign In Form ....................................................................................................................... 38 
Figure 24 - Current Users .............................................................................................................................. 39 
Figure 25 - Edit Menu ..................................................................................................................................... 40 
Figure 26 – Communication Service Level Context Menu ......................................................................... 40 
Figure 27 - Server Details .............................................................................................................................. 41 
Figure 28 – Connection Wizard – Serial Details .......................................................................................... 42 
Figure 29 – Connection Wizard – Ethernet Details ..................................................................................... 42 
Figure 30 – Connection Wizard – Timings ................................................................................................... 43 
Figure 31 – Connection Wizard – Identification .......................................................................................... 44 
Figure 32 - Connection Details ...................................................................................................................... 44 
Figure 33 – COM Port Panel Component ..................................................................................................... 45 
Figure 34 – Device Monitoring Wizard - Details .......................................................................................... 46 
Figure 35 – Device Monitoring Wizard - Identification ................................................................................ 47 
Figure 36 – Ethernet Device Connection Details ......................................................................................... 48 
Figure 37 – Device Details – Temperature Units Selection ........................................................................ 49 
Figure 38 – Device Details – Analog Formula Configuration ..................................................................... 50 
Figure 39 – Formula Configuration Form ..................................................................................................... 51 
Figure 40 - Background Properties............................................................................................................... 53 
Figure 41 – Selecting Multiple Panel Controls With The Mouse ................................................................ 54 
Figure 42 – Multiple Panel Controls Selected .............................................................................................. 54 
Figure 43 – Panel Control Display Properties ............................................................................................. 55 
Figure 44 - Boolean Styles of Panel Controls .............................................................................................. 56 
Figure 45 - Boolean Element Properties ...................................................................................................... 57 
Figure 46 – Analog Boolean Control Properties ......................................................................................... 58 
Figure 47 - Boolean Control On Condition .................................................................................................. 58 
Figure 48 - Knob Styles of Panel Controls ................................................................................................... 59 
Figure 49 - Knob Properties .......................................................................................................................... 60 
Figure 50 - Slide Styles of Panel Controls ................................................................................................... 61 
Figure 51 - Slide Style Properties ................................................................................................................. 62 
Figure 52 - Display Style of Panel Controls ................................................................................................. 62 
Figure 53 - Display Style Properties ............................................................................................................. 63 
Figure 54 - Celcius to Fahrenheit Conversion ............................................................................................. 64 



TASC siteVIEW 2.1 User Manual 050-015-0050 R07 

TASC Systems Inc. All Rights Reserved Page 9 of 175 

Figure 55 - Adding Text to Format String..................................................................................................... 65 
Figure 56 - Adding I/O to a Panel .................................................................................................................. 66 
Figure 57 - Panel Control Properties ............................................................................................................ 66 
Figure 58 – siteVIEW Alarm Condition States ............................................................................................. 68 
Figure 59 - Alarm Configuration Form.......................................................................................................... 69 
Figure 60 – Alarm Management .................................................................................................................... 70 
Figure 61 – Alarm Management .................................................................................................................... 71 
Figure 62 – Alarm Management .................................................................................................................... 71 
Figure 63 – Alarm Management .................................................................................................................... 72 
Figure 64 – Alarm Management .................................................................................................................... 72 
Figure 65 – Alarm Management .................................................................................................................... 73 
Figure 66 – Alarm Sound ............................................................................................................................... 74 
Figure 67 –Text to Speech ............................................................................................................................. 75 
Figure 68 - Alarm Recipients ......................................................................................................................... 75 
Figure 69 – Notification Configuration – Display Settings ......................................................................... 76 
Figure 70 – Notification Configuration – Email ........................................................................................... 77 
Figure 71 – Default Email Message Editor ................................................................................................... 78 
Figure 72 – Notification Configuration – Pager Settings ............................................................................ 79 
Figure 73 – Notification Configuration – FleetSync Settings ..................................................................... 80 
Figure 74 – Notification Configuration – SNMP Settings ........................................................................... 81 
Figure 75 - Polling Configuration Form ........................................................................................................ 82 
Figure 76 - Site Mapping Configuration Form ............................................................................................. 84 
Figure 77 – User Access Configuration ....................................................................................................... 85 
Figure 78 - Site Panel Example ..................................................................................................................... 87 
Figure 79 - Alarm Pop-Up Notification .......................................................................................................... 87 
Figure 80 - Alarm Details Form ..................................................................................................................... 88 
Figure 81 - Manual Poll Options .................................................................................................................... 89 
Figure 82 - siteVIEW Log Viewer ................................................................................................................... 91 
Figure 83 - siteVIEW Log Viewer - Options .................................................................................................. 94 
Figure 84 – Automated System Archive ....................................................................................................... 95 
Figure 85 – Manual System Archive & Restore ........................................................................................... 96 
Figure 86 – Sample Message Transaction Log File .................................................................................... 98 
Figure 87 – Sample Port Transaction Log File ............................................................................................ 98 
Figure 88 - Photo of Analog Jumpers ......................................................................................................... 102 
Figure 89 - External Resistor Network........................................................................................................ 103 
Figure 90 - Device Properties ...................................................................................................................... 104 
Figure 91 - Device Properties - General ..................................................................................................... 105 
Figure 92 - Device Properties - Startup Options ....................................................................................... 106 
Figure 93 - Device Properties - Communication ....................................................................................... 107 
Figure 94 - Device Properties - FFSK Communication ............................................................................. 108 
Figure 95 - Device Properties - Contact Inputs ......................................................................................... 108 
Figure 96 - Device Properties - Analog Inputs ........................................................................................... 110 
Figure 97 - Device Properties - Temperature Inputs ................................................................................. 111 
Figure 98 - Device Properties - Outputs ..................................................................................................... 112 
Figure 99 - Device Properties - Device Logging ........................................................................................ 112 
Figure 100 - Device Data Logger ................................................................................................................. 114 
Figure 101 - Device Details - Description ................................................................................................... 116 
Figure 102 - Device Details - General ......................................................................................................... 117 
Figure 103 - Device Details – Call & Modem Control ................................................................................ 118 
Figure 104 - Device Properties – Contact Inputs ....................................................................................... 120 
Figure 105 - Device Properties – Analog Inputs ........................................................................................ 121 
Figure 106 - Device Properties – Temperature Inputs .............................................................................. 122 
Figure 107 - Device Properties – Outputs .................................................................................................. 123 
Figure 108 - Device Properties – Site Information .................................................................................... 124 
Figure 109 - Device Properties – Peripherals ............................................................................................ 125 
Figure 110 – Starting Peripheral Passthrough .......................................................................................... 126 
Figure 111 – Peripheral Passthrough Connection Waiting ...................................................................... 126 



TASC siteVIEW 2.1 User Manual 050-015-0050 R07 

TASC Systems Inc. All Rights Reserved Page 10 of 175 

Figure 112 - Device Details - Description ................................................................................................... 129 
Figure 113 - Device Details - General ......................................................................................................... 129 
Figure 114 - Device Details – Communication ........................................................................................... 130 
Figure 115 - Device Properties – Contact Inputs ....................................................................................... 131 
Figure 116 - Device Properties – Analog Inputs ........................................................................................ 133 
Figure 117 - Device Properties – Temperature Inputs .............................................................................. 134 
Figure 118 - Device Properties – Outputs .................................................................................................. 135 
Figure 119 - Ping Device - Add Device ....................................................................................................... 137 
Figure 120 - Ping Device - Non-Responsive Alarms ................................................................................. 138 
Figure 121 – Communication Alarms – Non-Responsive Alarms ........................................................... 143 
Figure 122 – Communication Logging System – Transmit Receive Log Files ...................................... 144 
Figure 123 – Communication Logging System – Communication Service Log File ............................. 145 
Figure 124 – siteVIEW to siteRSM Connections ........................................................................................ 148 
Figure 125 – Connection Management – Device Status Poll ................................................................... 149 
Figure 126 – siteRSM Tunnel Settings – XPort Pro ................................................................................... 150 
Figure 127 – siteRSM Tunnel Settings - XPort .......................................................................................... 151 
Figure 128 – siteRSM Tunnel Settings ....................................................................................................... 152 
Figure 129 - Ethernet Port Communication - Add Device ........................................................................ 154 
Figure 130 - Ethernet Port Communication - Monitoring Port Health ..................................................... 155 
Figure 131 - Migrating to Ethernet - siteRSM Config Logon Screen ....................................................... 156 
Figure 132 - Migrating to Ethernet - Telnet Config .................................................................................... 157 
Figure 133 - Migrating to Ethernet - Select Channel ................................................................................. 158 
Figure 134 - Migrating to Ethernet - Flush Mode ....................................................................................... 159 
Figure 135 - Migrating to Ethernet - Save Config ...................................................................................... 160 
Figure 136 - Migrating to Ethernet - Create Ethernet Port ........................................................................ 161 
Figure 137 - Migrating to Ethernet - Add Device ....................................................................................... 161 
Figure 138 - Migrating to Ethernet - Export Panel ..................................................................................... 162 
Figure 139 - Migrating to Ethernet - Import Panel ..................................................................................... 163 
Figure 140 - Migrating to Ethernet - Update Formulas ............................................................................. 163 
Figure 141 - Migrating to Ethernet - Adjust Scheduled Polls ................................................................... 164 
Figure 142 – Sample Panel Layout ............................................................................................................. 167 
Figure 143 – Default siteVIEW Controls ..................................................................................................... 170 
Figure 144 – Standard siteVIEW Icon Set .................................................................................................. 172 

  
 
 

INDEX OF TABLES 

Table 1 – Product Comparison ...................................................................................................................... 18 
Table 2 – Login Security Level Matrix .......................................................................................................... 38 
Table 3 – Recommended Communication Timing Parameters ................................................................. 43 
Table 4 - Device Properties – Analog Jumper Configuration .................................................................. 102 
Table 5 - Device Properties – Analog Jumper Ranges ............................................................................. 103 
Table 6 - Device Properties – Suggested External Resistor Network Values ........................................ 103 

 



 TASC siteVIEW 2.1 User Manual 050-015-0050 R07 

TASC Systems Inc. All Rights Reserved Page 11 of 175 

RELATED DOCUMENTS 

 siteCOMMANDER User Manual (050-015-0002) 

 sitePORTAL Lite User Manual (050-015-0012) 

 siteRSM User Manual (050-015-0052) 

 siteVIEW 2.0 Quick Start Guide (050-015-0063) 

 
 



TASC siteVIEW 2.1 User Manual 050-015-0050 R07 

TASC Systems Inc. All Rights Reserved Page 12 of 175 

REVISION HISTORY 

 
 

Revision Date Changes 

050-015-0050R00 April 2009 
 Assign new document number (previously 0039) 

 R03 reset to R00 for first public release  

050-015-0050R01 April 2009  Update Figure 60 and 61 

050-015-0050R02 December 2009 

 Added Figures 37 and 38 

 Added Appendix, C Section 10 

 Rename Manual 

 Made manual generic to apply to both siteVIEW 
Enterprise 2.0 and siteVIEW scope 2.0, with product 
comparison sheet 

050-015-0050R03 March 2010 

 Added analog formula to section 6.3.2 

 Added Figures 36, 37, 38 and 39 

 Added a note to section 6.4.4 regarding analog 
formulas 

050-015-0050R04 March 2011  Added Log All Feature  

050-015-0050R05 May 2013 

 siteVIEW deployment and administrative  

 Communication Service log file system 

 SNMP global settings and notifications 

 Contextual options for Alarm panel 

 siteVIEW software components diagram and related 
connection management 

050-015-0050R06 September 2013 
 Alarm conditions and alarm management information 

 Panel design information 

050-015-0050R07 August 2014 

 Includes updates for siteVIEW 2.1 

 Appendix E: Ping Devices 

 Appendix F: siteVIEW to Device Communication 



TASC siteVIEW 2.1 User Manual 050-015-0050 R07 

TASC Systems Inc. All Rights Reserved Page 13 of 175 

1. PRODUCT DESCRIPTION 

1.1. GENERAL DESCRIPTION 

TASC siteVIEW 2.1 is a distributed monitoring software package designed to 
work in conjunction with TASC hardware monitoring products. Currently 
siteVIEW supports the siteCOMMANDER, sitePORTAL lite, siteRSM and the 
ability to ping third party IP based network devices.  

siteVIEW is built with an easy to use graphical user interface (GUI) that 
provides visibility into a network of devices. This simplifies the task of site 
monitoring by centralizing all site information and communication into a 
single software package.  

siteVIEW allows for multiple simultaneous client connections to the siteVIEW 
data warehouse. With this ability, it is possible to setup a group of operators 
or dispatchers, in one or multiple locations, to supervise and control devices 
in the network. 

siteVIEW 2.1 Components: 

 Data Handler 

 Data Warehouse 

 Logging Interface 

 Communication Service 

 Alarm Notification Handler 

 User Interface 

 Client GUI 

 Log Viewer 

1.2. Installation Requirements 

1.2.1. Data Handler Requirements 

 

 Microsoft Windows 2000/XP/Vista/7/Server 

 Microsoft .NET Framework 3.5 or later 

1.2.2. Communication Service Requirements 

 

 Microsoft Windows 2000/XP/ Vista/7/Server 

 Microsoft .NET Framework 3.5 or later 
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1.2.3. Alarm Notification Handler Requirements 

 Microsoft Windows 2000/XP/ Vista/7/Server 

 Microsoft .NET Framework 3.5 or later 

1.2.4. User Interface Requirements 

 Microsoft Windows 95/98/2000/XP/ Vista/7/Server 

 Microsoft .NET Framework 3.5 or later 

 Microsoft DirectX 9.0 or later 

1.3. siteVIEW Key Features 

N-Tier Software Architecture 

Device Configuration and Monitoring 

Various Alarm Reporting Options  

Multi – Protocol Communication Routing 

Scheduled Polling and Log Retrieval 

Site-to-Site Output Mapping 

Custom Panel Backgrounds 

Drag and Drop Site Panel Controls 

Site Grouping 

Kenwood FleetSyncTM Protocol Integration 

Simple Licensing Scheme 
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2. INTRODUCTION 

2.1. N-Tier Software Architecture 

siteVIEW is based on an N-Tier software model with several components 
that are responsible for different components of the system. There is a 
central Data Handler service that manages access to the data that is stored 
in the Data Warehouse and several services that connect to each other.  

The logging interface is installed with the Data Handler and provides access 
to the siteVIEW logs. The log viewer is installed with the siteVIEW User 
Interface and it connects to the logging interface. 

 

Figure 1 – siteVIEW Software Component Architecture 

The Alarm Notification Handler provides services for notifying recipients of 
alarms via email or pager notifications. 

One or more Communication Service(s) clients handle communication with 
one or more sites through communication ports on the PC. A Communication 
Service communicates with devices and then forwards the received data on 
to the Data Handler where the data is then interpreted and stored in the Data 
Warehouse. Multiple Communication Services can be connected to the same 
Data Handler at the same time. 
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The siteVIEW User Interface connects to the Data Handler and requests the 
stored information and displays it in an organized manner. Multiple user 
interfaces can be connected to the Data Handler at the same time and can 
view information for any Communication Services connected to the Data 
Handler. 

Each application is installed using its own installation program. All four 
applications can be installed on the same computer or on separate 
computers. There can be only one Data Handler and Alarm Notification 
Handler active for each system, but there can be several Communication 
Services and user interfaces installed on several computers.  

2.2. siteVIEW 2.1 Licensing 

2.2.1. The Security Key 

The TASC siteVIEW security key is a USB device, which contains: 

 One Server License 

 User Licenses 

 Feature Add-Ons/Options 

The Data Handler computer must have a security key in order for site 
monitoring to occur. The Data Handler service reads the security key and 
retrieves the number of user licenses available and determines which feature 
add-ons are allowed.  

The number of user licenses, determines the number of operators that can 
sign into siteVIEW User Interface at any one time. 

Any Feature Add-on licenses present determine whether or not certain 
features in siteVIEW are enabled. The available Feature Add-ons are viewed 
in the About form, which can be viewed by selecting “Help->About” from the 
main menu. 

Note: If the security key is removed from the computer, or if the Data Handler 
Service is stopped for any reason, site monitoring stops and any user licenses 
or Feature Add-on’s associated with the security key are disabled until the 
Data Handler Service restarts or the key is re-inserted. 

 

Note:  siteVIEW scope 2.1 is configured to accommodate 1 user license. 
siteVIEW Enterprise 2.1 can be purchased with various user license quantities. 
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2.2.2. Feature Add-Ons/Options 

 

Some features in siteVIEW must be enabled via the security key before they 
will be available. siteVIEW add-ons include: paging, email, the Kenwood 
FleetSyncTM protocol, the redundant Data Handler and the various individual 
devices.  

The security key’s licenses and various Feature Add-ons are factory 
configured by TASC Systems Inc. 

Note: System add-ons are limited when using siteVIEW scope 2.1.  

 

Note: The software screen shots in this manual may appear differently 
depending on the version of the software, the feature Add-ons that are enabled 
and the operating system that the software is running on. 
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2.2.3. Comparison of TASC siteVIEW 2.1 Products 

 
TASC siteVIEW scope 2.1 is designed to manage and monitor smaller device 
networks, while TASC siteVIEW Enterprise 2.1 is designed for medium and large 
networks. The following table is a product comparison between the two products. 
 

 

 

 

   

siteVIEW scope 2.1 siteVIEW Enterprise 2.1 

Site Monitoring Yes Yes 

Panel Configuration Yes Yes 

Device Configuration Yes Yes 

Alarm Notification Yes Yes 

Automated Polling Yes Yes 

Site-to-Site Output 
Mapping 

Yes Yes 

Log Viewer Yes Yes  

Site Grouping  Yes Yes  

Password Encryption Yes Yes 

Kenwood FleetSync
TM

 Yes Yes 

Email Yes Yes 

Number of Concurrent 
Users (Licenses) 

1 Security Key Configured 

Max Number of Devices 3 Unlimited 

System add-ons No Yes 

siteRSM Yes Yes 

siteCOMMANDER Yes Yes 

sitePORTAL Lite Yes Yes 

Pingable 3
rd

 Party Device No Security Key Configured 

Table 1 – Product Comparison 
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3. SOFTWARE CONFIGURATION 

3.1. Installing the System 

The entire siteVIEW system can be installed on a single computer, or each 
component can reside on different computers connected via TCP/IP netware.  

1. Start by installing the Data Handler and configure the Data Handler. See 
Configuring the Data Handler, section 3.1.1, on page 19 of this manual. 

2. Install the siteVIEW 2.1 client application and configure it to connect to 
the Data Handler. See Starting the User Interface, section 0, on page 23 
of this manual. Several client applications may be installed on different 
computers and used simultaneously to connect to the Data Handler. 

3. Install a Communication Service and configure it so that it can connect to 
the Data Handler. See Configuring the Communication Service, section 
3.3, on page 22 of this manual. Several Communication Services running 
on different computers can be configured within the system. 

4. Install an Alarm Notification Handler and configure it so that it can 
connect to the Data Handler. See Configuring the Alarm Notification 
Handler, section 3.4, on page 23 of this manual. Only one Alarm 
Notification Handler is needed in the system. 

5. Using the siteVIEW 2.1 client application, configure communication ports, 
devices, alarm conditions & notification, users, site mapping, automated 
polling, panels and more. 

 

3.1.1. Distributed Installations of siteVIEW Components 

If siteVIEW software components are to be installed as a distributed system 
over multiple platforms and networks to balance load and/or manage system 
architecture, the following considerations are recommended: 

 The firewall mechanism for each platform, either Windows or other 
third-party, must allow the siteVIEW specific ports. For example, if 
you are using port 11003 to connect the siteVIEW client from one 
platform to a Data Handler on another platform, both platforms should 
permit port 11003 usage. 

 If the platforms are distributed over different networks and/or 
accessible via public IP address, it may be necessary to configure 
your system’s router to port-forward to the internal platform’s 
connection.  
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3.2. Configuring the Data Handler 

By default the Data Handler is configured to monitor incoming client 
connections on port 11003. The Logging Interface installs with the Data 
Handler and it is configured to monitor incoming Log Viewer connections on 
port 11006. The default ports can be changed using the Data Handler Utility 
(DataHandlerConfigTool.exe), which can be accessed from the windows start 
menu at: 

Start->Programs->TASC->Data Handler Utility 

 

Using the Data Handler Utility you can change the port numbers that the 
Data Handler and Logging Interface will monitor. Press the save button to 
save any changes you make and then stop and start the services to get the 
Data Handler and Logging Interface to run with the changed settings. 

Valid port numbers range from 0 to 65535, but ports numbers 0 to 1024 are 
reserved for privileged services and designated as well-known ports and 
should be avoided. 

Log All is a feature that when enabled, will log all I/O levels when polling and 
not just the changes in I/O levels. 

Once the changes have been saved and the Data Handler or Logging 
Interface services have been restarted, press exit to minimize the Data 
Handler Utility to the system tray. If you wish to close the Data Handler Utility 
completely, right click on the system tray icon and select exit. 

 

Figure 2 – Data Handler Utility – Configuration Tab 
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From the activity tab of the Data Handler Utility, the system can be monitored 
for progress while it is loading, or an administrator can check that no updates 
are waiting to be saved to the database before shutting the Data Handler 
down or restarting the computer. 

 

When the Data Handler runs, it waits for connections from Communication 
Services and User Interfaces. When the Logging Interface runs, it waits for 
connections from client Log Viewers. By default, the Data Handler and 
Logging Interface services start automatically after the installation and every 
time the computer is restarted. These services continue to run as a 
background service even if no user is logged into the computer.  

The Data Handler Utility is configured from the installation program to start 
automatically on login to the windows operating system. 

 

Figure 3 – Data Handler Utility – Activity Tab 
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3.3. Configuring the Communication Service 

 

Each Communication Service must be configured to connect to the Data 
Handler using the Communication Service Configuration Tool 
(CommServiceConfigTool.exe), which can be accessed from the windows 
start menu at: 

Start->Programs->TASC->Communication Service Configuration Tool 

Using the configuration tool you can type the IP Address or DNS Name of the 
computer where the Data Handler is installed. Press the save button to save 
any changes you make and then stop and start the service to get the 
Communication Service to run with the changes. 

Once the changes have been saved and the Communication Service has 
been restarted, press exit to close the Communication Service Configuration 
Tool. 

The Communication Service will automatically connect to the Data Handler 
and monitor ports it has been configured to monitor. By default, the 
Communication Service starts automatically after the installation and every 
time the computer is restarted. The Communication Service continues to run 
as a background service even if no user is logged into the computer. 

You will know if the Communication Service has connected successfully by 
running the siteVIEW Client application and viewing connected 
Communication Services. 

 

If the Communication Service is running on the same machine 
as the Data Handler, the recommended IP Address is localhost 
(127.0.0.1). 

 

Figure 4 – Communication Service Configuration Tool 
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3.4. Configuring the Alarm Notification Handler 

 

The Alarm Notification Handler must be configured to connect to the Data 
Handler using the Alarm Notification Handler Configuration Tool 
(AlarmHandlerConfigTool.exe), which can be accessed from the windows 
start menu at: 

Start->Programs->TASC->Alarm Notification Handler Configuration Tool 

Using the configuration tool you can type the IP Address or DNS Name of the 
computer where the Data Handler is installed. Press the save button to save 
any changes you make and then stop and start the service to get the Alarm 
Notification Handler to run with the changes. 

Once the changes have been saved and the Alarm Notification Handler has 
been restarted, press exit to close the Alarm Notification Handler 
Configuration Tool. 

The Alarm Notification Handler will automatically connect to the Data Handler 
and monitor ports it has been configured to monitor. By default, the Alarm 
Notification Handler starts automatically after the installation and every time 
the computer is restarted. The Alarm Notification Handler continues to run as 
a background service even if no user is logged into the computer. 

 

If the Alarm Notification Handler is running on the same machine 
as the Data Handler, the recommended IP Address is localhost 
(127.0.0.1). 

 

Figure 5 – Alarm Notification Handler Configuration Tool 
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3.5. Starting the User Interface 

3.5.1. Logging In to siteVIEW 

To launch the siteVIEW user interface, double click on the “siteVIEW 
Enterprise 2.1” icon or the “siteVIEW scope 2.1” icon that the installation 
placed on the computer desktop. 

This can also be accomplished from the Windows start menu, select 
“Programs->TASC->siteVIEW Enterprise 2.1” or “Programs->TASC-
>siteVIEW scope 2.1” 

After launching siteVIEW, one of two things should occur: 

 If the siteVIEW User Interface is able to connect to a siteVIEW Data 
Handler, a Sign In form will appear. This is a typical scenario if the 
Data Handler is installed on the same computer as the user interface, 
or if the Data Handler Service connection was established previously. 

 If the host computer exists, but the siteVIEW User Interface is not 
able to connect to the siteVIEW Data Handler Service, the siteVIEW 
user interface will launch and at the bottom left corner of the 
application, the words “Attempting Connection With Server: 
<servername>” appear, where <servername> is the name of server 
specified. Then when the connection fails, the words “No Connection” 
appear. siteVIEW will then continue attempting the connection. 

    

Figure 6 – siteVIEW 2.1 User Interface 
Desktop Shortcut Icon 

 

Figure 7 - User Interface - Sign In 
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To connect to the Data Handler, select “Connect->Connect to Server” from 
the main menu and you will be presented with a connection form. 

Enter the IP Address or the DNS machine name of the computer where the 
Data Handler is installed. During the client installation, the default Data 
Handler connection is set up as 127.0.0.1 with port 11003.  

 

If the siteVIEW User Interface is running on the same machine 
as the Data Handler, the recommended IP Address is localhost 
(127.0.0.1). 

 

 

 

Figure 8 - User Interface - Not Connected to Data Handler 

 

Figure 9 – Data Handler Connection Form 
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Once the Sign In form appears, sign in using a valid username and 
password. When signing in to siteVIEW for the first time, use the username 
svadmin with password siteview. The svadmin is an administrator account 
with full rights to every part of siteVIEW. 

Note: To ensure proper security, change the svadmin password during the first 
sign in 

3.5.2. Password Recovery 

There is a password-recovery link on the login form, but it only works if a 
user has setup their email address.  

After selecting the password-recovery link, the user specifies the username. 
An email containing their password information is sent to the user's email 
account. An administrative user can set the default SMTP server in the 
notification options form. If the SMTP server is not set, the password-
recovery email will fail. 

When a user logs in they are reminded to set their email address each time 
they log in until they set an email address. Admin users can set their email 
address and the email addresses of other users in the user admin form.  

Non-administrative users can set their email address by selecting “Connect-
>Accounts->Change Email Address” from the main menu. 

A message is displayed to the user to tell them if the email was sent or not. 
The email is then sent to the SMTP server, which may fail to send the email 
for other reasons. 

 

3.6. Redundant Data Handler 

A redundant Data Handler option is available in siteVIEW, where a second 
Data Handler waits and is ready to take over in case the primary Data 
Handler goes offline for some reason. 

Note: The Redundant Data Handler is only available if the security key has 
been configured to allow the Redundant Data Handler as a siteVIEW 2.1 option 
and it is only available as an option in a siteVIEW Enterprise 2.1 system. 

3.6.1. Configuration 

Setup and configure the redundant Data Handler in the same way as the 
main server. 
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To setup a redundant Data Handler, use the Data Handler using the same 
version of installation program as was used to install the primary Data 
Handler. The redundant Data Handler must be installed onto a different 
computer than the primary Data Handler, but also the redundant Data 
Handler requires a special redundant Data Handler security key before it will 
take on the role of a redundant Data Handler. 

When the redundant server security key is located, the configuration utility 
provides a way of connecting to the primary Data Handler. Specify the port 
and IP address or name of the primary Data Handler, save the configuration 
and then stop and restart the redundant Data Handler. The redundant Data 
Handler will then connect to the primary Data Handler and will register itself 
in the system, synchronize its data, and wait as a backup server.  The main 
server then notifies the connected clients of the location of the redundant 
Data Handler. In the event that the main server becomes unavailable for 
some reason, the Communication Services and client User Interfaces will 
attempt to connect to the redundant Data Handler until the primary Data 
Handler comes back online. 

A redundant Logging Interface is installed when the redundant Data Handler 
is installed. When the redundant Data Handler takes over from the main Data 
Handler, the redundant Data Handler will store historical data temporarily. 
When siteVIEW client User Interfaces connect to the redundant Data Handler 
and a user attempts to open the Log Viewer, they will connect to the 
redundant Logging Interface and so the data seen will not show the data that 
is stored on the main Data Handler. Once the main Data Handler is up and 
running again, it will take over as the main Data Handler once more and the 
redundant Data Handler will update the main Data Handler with all the 
historical data that was saved by the redundant Data Handler. 

 

Figure 10 – Redundant Data Handler Configuration Utility 
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Note: Ensure that the redundant server is visible through the network to the 
Communication Services and the clients. 

The status bar of the siteVIEW client then shows the location and status of 
the redundant Data Handler.  

As well the status bar indicates when the client is connected to the redundant 
Data Handler instead of the main one. 

 

 

 

Figure 11 – Redundant Data Handler Status 

 

Figure 12 – Connected to Redundant Data Handler 
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4. THE GRAPHICAL USER INTERFACE 

The TASC siteVIEW 2.1 user interface consists of a main application window 
that is divided into several sections 

A. Site Navigation Tree - A tree view of the nodes in a network  

B. Main Menu – Contains all available menu options 

C. Toolbar – Quick access to routine functions 

D. Alarm Panel – Detailed listing of all alarms 

E. Site Panel – Graphical display of sites or network 

F. Panel Components – Interactive elements in the network 

G. Status Bar – Real time program information 

H. Communication Panel – Listing of network communications 

I. Bandwidth Meter – Displays network data passed to and from siteVIEW 

 

Figure 13 - siteVIEW User Interface 
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4.1. Site Navigation Tree 

The Site Navigation Tree is a logical representation of a network of 
monitoring devices (ie. siteCOMMANDER), which are capable of reporting 
input and output states to siteVIEW through a communication port (COM 
port) on the Communication Service. 

The first level node is of the Site Navigation Tree represents the complete 
siteVIEW system, which contains a ‘Groups’ node and a ‘Network’ node.  

The Groups node contains custom arranged groups of devices and folders. 
The “Groups” node’s purpose is to arrange devices into custom groupings. 
Add sub-folders to the “Groups” node and then drag device links into various 
folders. Right-click on the mouse will provide the additional Cut to Group (for 
moving to a new group), Copy to Group and Paste to Group options. 

The first level nodes of the Network represent Communication Services that 
are connected to the Data Handler. The second level nodes of the Network 
represent the monitored communication ports on the Communication 
Service. The communication ports are used for monitoring remote devices. 
The third level of Network represents the physical device. 

Right clicking on one of the tree nodes levels (i.e. system, groups, network, 
server, COM port, device) allows quick access to menu options, by 
displaying a context menu that pertains to the selected node. 

Left clicking on a node updates the site panel to display a graphical 
representation of all nodes beneath the selected node. 

4.2. Main Menu 

The main menu allows access to configuration and monitoring of the tree 
nodes. Some menu items change depending on the node selected, and also 
depending on the user’s security rights (See Managing User Accounts, 
section 5.1, on page 37 of this manual.) 
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4.3. Tool Bar 

The toolbar allows quick access to some menu options 

A. Lock/Unlock Site Panel layout 

B. Perform manual poll of the selected portion of the network 

C. Hide/Show Site Navigation Tree 

D. Hide/Show Alarm Panel 

E. Hide/Show Communication Panel 

F. Hide/Show Site Panel 

G. View logs 

4.4. Alarm Panel 

The alarm panel displays a list of alarms that have not been cleared at the 
remote site. Each alarm item in the alarm panel has the following information: 

 

Figure 14 - Toolbar Buttons 

 

Figure 15 - Alarm Panel Components 
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A. Port & device name of the alarm and the last time the alarm status 
changed 

B. Auto-find button 

C. Alarm ID and status 

D. Alarm severity and the name of the I/O where the alarm condition 
occurred 

The auto-find button appears as a square button with a question mark in the 
center. Selecting the auto-find button causes the corresponding device node 
to be selected on the Tree View and for the corresponding panel to be 
drawn. 

Double clicking on an alarm shows more detailed information about the 
selected alarm and allows the user to acknowledge and clear the alarm. 

When an alarm is active and unacknowledged, the alarm will flash a different 
color depending on the severity of the alarm.  

Right-clicking the mouse in the Alarms panel area provides additional 
contextual options: 

 Use the “Clear All Alarms” to clear all ceased alarms 

 Access detailed information about the selected alarm 

 View a historical summary of alarms within the Log Viewer 

4.5. Site Panel 

The site panel displays a graphical representation of the currently selected 
tree node. This provides simplified visibility in networks of monitored devices.  
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At the top of the site panel is a status bar that displays the full path name of 
the selected network tree node. 

Device outputs can be controlled from the site panel. 

The size, component placement, background image and color of the panel 
can all be customized. (See Site Panel, section 6.4, on page 52 for 
information on customizing the site panel) 

When a device’s panel is selected, the ability to add more panels is available. 
A panel selection tab appears on the bottom of the device panel. This feature 
allows a device to be represented in multiple ways. Press the far right tab 
with a plus (+) sign on it to add a new panel, or right click on the panel and 
select the “Insert New Panel” option. From the same menu you can also 
rename the selected panel or delete it. If a device only has one panel, it 
cannot be deleted. The menu options can also be accessed from the main 
menu by selecting “Edit->Panel”. 

 

Figure 16 – Site Panel 
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4.6. Panel Components 

The Site Panel is made up of images, text and panel components. Panel 
components are interactive elements that allow the operator to navigate as 
well as monitor and control various areas of their network. Panel components 
include virtual knobs, buttons, lights, switches, labels, temperature gauges 
and more. 

At a sever node, Panel Components represent the available and configured 
COM ports that are accessible on the network. 

At a COM Port node, panel components represent the available and 
configured devices accessible on the network. 

At a device node, Panel Components represent the specific physical inputs 
and outputs available to a particular device. 

The type, size, color, font and many other configuration options can be 
customized. (See Panel Control Property Form, section 6.4.2, on page 53 for 
information on customizing the panel controls) 

4.7. Status Bar 

The status bar is used to display various messages to the user. The far left of 
the status bar displays the Data Handler connection status and the far right 
displays the user login status. The center of the status bar shows the online 

status of the Alarm Notification Handler and if installed, the Redundant Data 
Handler. 

4.8. Communication Panel 

The communication panel contains recent network communication traffic and 
the following details pertaining to those transactions: 

 

Figure 17 - Status Bar Components 
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 A. Name of COM port and device the communication pertains to and 
the time when the communication request occurred 

 B. Cancel transaction button 

 C. Communication transaction status 

 D. Communication transaction command and subcommand 

When a new communication transaction is added to the communication 
panel, any transactions that are older than 8 seconds and are no longer 
processing, are removed from the communications panel. 

Output control traffic is considered a special case. By updating an output a 
user either turns on or turns off that output. The output that is affected and 
the state that it is being set to are displayed next to the command and 
subcommand. 

 

Figure 18 - Communication Panel 

 

Figure 19 - Outputs Update Communication 
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4.9. Bandwidth Meter 

The bandwidth meter shows how much data is being transmitted (TX) and 
received (RX) by the siteVIEW client. The data is displayed in kilobits per 
second (kbps) and is updated every second. There are 8192 kilobits in 1 
Megabyte (MB). 

To see the total amount of data sent or received, hover the mouse pointer 
over the corresponding label. 

 

 

Figure 20 – Bandwidth Meter 
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5. USER ADMINISTRATION 

5.1. Managing User Accounts  

To create, modify or delete siteVIEW user accounts open the user 
administration form, which can be viewed by selecting “Connect->Accounts-
>User Administration” from the main menu. 

 

 The following tasks may be performed using the user administration form: 

 Create new user accounts 

 First name, last name and username may be altered 

 Security rights may be altered 

 User accounts may be enabled or disabled 

 The user’s password can be set 

 User specific alarm notification options may be set, depending on 
which options are available from within siteVIEW (ie. email, paging, 
etc). 

 Existing users may be deleted from the system 

 View a history of user login/logout activity 

 The user’s email address can be set. This is used for password-
recovery purposes (If email is enabled in the system the email 
address can also be used for email notification.) 

 

Figure 21 - User Administration 
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The following table lists the available security rights and the access 
associated with each type: 

5.1.1. Changing An Account Password 

A user can change their account password through the  “Change Password” 
form by selecting “Connect->Accounts->Change Password.” 

5.1.2. Forced User Sign Out 

In the case of a power failure or a system crash/reset, siteVIEW may not get 
a chance to properly sign users out of the system. Also, there may be times 
when an operator(s) needs to be forcibly signed out of the system.  

In either case, operators may be forced out by anyone who has more 
security rights than they do. Operators may also sign themselves out. To 
view users that are currently signed in, type in a valid username and 
password at the sign in prompt, and select the “Users” button. 

   User 
Maintenance 

Device & 
System 

Configuration 

Panel 
Layout 

Alarm 
Control 

Manual 
Polling 

Output 
Control 

View Only None Read Read Read Read Read 

User None Read Read Read/ Write Read/ Write Read/ Write 

Admin Read/ Write Read/ Write Read/ Write Read/ Write Read/ Write Read/ Write 

Table 2 – Login Security Level Matrix 

 

Figure 22 - Changing Your Password 

 

Figure 23 - User Sign In Form 
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This will open the “Current Users” form, with a list of users that are currently 
signed in, the computer that the user signed in from, and the date and time 
the he or she signed in.  

To sign a user out, select the user from the list of currently signed in users 
and select “Sign out”. 

 

Figure 24 - Current Users 
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6. SYSTEM CONFIGURATION 

The entire siteVIEW system is represented in two ways: it is represented as 
a logical tree, which is referred to as the Site Navigation Tree, and as a 
graphical panel, which is referred to as the Site Panel. Items in the site 
navigation tree are referred to as nodes. 

When a node on the tree is selected, menu options pertaining to that node 
are accessible through both the main menu, which is located at the top of the 
User Interface, and the context sensitive popup menu, which can be 
accessed by selecting a node with the mouse and then performing a right 
mouse click. This document will explain how to configure siteVIEW using the 
main menu, but the same functionality can be accessed using the context 
specific popup menu. 

The Tree View displays a list of Communication Services, the COM ports in 
use by the Communication Service and the devices that are monitored 
through the COM port(s). Main menu items pertain to the selected node. 

Note: Only the administrator users can configure the system. 

 

6.1. The Communication Service 

The Communication Services, which are connected to the system, are visible 
in the site navigation tree. To view information pertaining to a particular 
Communication Service, select the desired node in the site navigation tree 

 

Figure 25 - Edit Menu 

 

Figure 26 – Communication Service Level 
Context Menu 
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and then select “Edit->Properties” from the main menu. This launches the 
server details form. 

The server details form displays the machine name that the Communication 
Service resides on and its software version.  

By default, siteVIEW uses the NetBIOS name of the server for the name of 
that server node in the site navigation tree. Using the alias field, a system 
applicable name can be used. The alias and description are the only items 
on the server details form that can be modified.  

Note: Existing archived log files will still contain the old 
Communication Service alias name.  

6.2. Communication Ports 

6.2.1. Adding A New Communication Port 

Each Communication Service potentially has available serial and Ethernet 
Com Ports, which can be used to monitor networks of hardware devices. To 
add and configure an available COM port for siteVIEW monitoring, select 
“Edit->Add New Communications Port” from the main menu. This launches 
the Connection Wizard. 

In the first stage of the Connection Wizard form, select the COM Port type. If 
the selected type is Serial then a list of available serial communication ports 
will be displayed in the port drop down list. Select the port and protocol, and 
select “PSTN Modem Port” if the port is an internal PSTN modem or if it is 
connected to an external PSTN modem.  

 

Figure 27 - Server Details 
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If the selected COM Port type is Ethernet then Ethernet connection will be 
displayed. The IP Address and Port of the remote Ethernet device will not be 
needed until the Ethernet devices are added.  

After entering the required serial or Ethernet information, select next.  

For a serial device, enter the port timing parameters. The Packet Timeout is 
entered in milliseconds and is the maximum amount of time a COM Port 
should wait for a response after sending out a request. The Inter-Byte 
Timeout is also entered in milliseconds and is the maximum time a COM Port 
should wait between incoming data bytes before the incoming data is 
considered complete. The Ethernet timing parameters are entered when you 
add the device. 

If COM Port communication is timing out too often, it may be that the packet 
timeout is too short. If communication is taking too long to complete, try 
reducing the packet timeout. 

 

Figure 28 – Connection Wizard – Serial Details 

 

Figure 29 – Connection Wizard – Ethernet Details 
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If COM Port communication results in abnormally high communication errors, 
it may be that the inter-byte timeout is too low. Setting the inter-byte timeout 
too high also results in the packet timeout taking too long. 

 

Change the Packet Retries to specify the number of times a port should retry 
packets that have no response. 

Experiment with the timings until you achieve the fastest and most reliable 
communication. 

 

As an additional step for optimizing communications, review the 

TransmitReceiveCOMxx (where xx is the COM port number) log 

files found within the CommSvc directory to view retries for a 
given COM port. Iteratively, using manual Full Refreshes to test 
communication exchange, adjust the Packet Timeout parameter 
to minimize retries recorded within the log file. 

Defaults: Packet Timeout 2000 msec; Inter-byte Timeout 70 msec; Packet 
Retries 3. 

 

After selecting the timing parameters, select next. Choose a name for the 
connection and a description to remind users of useful information about the 
connection and then select finish to add the COM Port. 

 

Figure 30 – Connection Wizard – Timings 

COM Port Configuration Packet Timeout (msecs) Inter-Byte Timout 
(msecs) 

Ethernet 1000-1500 50-100 

Serial 1000-3000 50-200 

Serial with PSTN Modem 2000-5000 100-300 

Serial with Radio Depends on the 
technology used and the 
number of radio hops. 

Depends on the 
technology used and the 
number of radio hops. 

Table 3 – Recommended Communication Timing Parameters 
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6.2.2. Configuring an Existing Communication Port 

To view and change information pertaining to a particular COM port on a 
Communication Service, select the desired COM port node on the Tree View 
and then select “Edit->Properties” from the main menu. This launches the 
Connection Details form. 

Select a name for the COM port. The name will be how siteVIEW refers to 
this communication port throughout the application.  

Note: Existing archived log files will still contain the old port name. 

 

Figure 31 – Connection Wizard – Identification 

 

Figure 32 - Connection Details 
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The description properties of both the COM port and device detail forms are 
displayed when a user hovers the mouse above a Site Panel control that 
represents the COM port or device. 

Changes can only be made to port settings if the port is offline or by closing 
the port by disabling monitoring.  

For a serial connection, the COM port field contains a list of communication 
ports available on the Communication Service. For an Ethernet connection, 
the IP Address and Port fields must be specified.  

The Protocol drop down field sets the protocol, which is used to 
communicate on the communication port. By default this protocol is set to 
BinMP. Other protocols are available as Add-On features from TASC. 

Two COM port timeout values exist. The packet timeout is the time the 
Communication Service will wait for a reply after transmitting a 
communication packet to a device. When the Communication Service is 
receiving a response packet, the packet bytes are received one at a time. 
The inter-byte timeout is the time in which the Communication Service should 
wait between packet bytes, before deciding the packet has failed.  

By increasing the packet timeout and the inter-byte timeout, siteVIEW is 
more likely to receive a packet. If siteVIEW needs to frequently retry packet 
transmissions, it is possible that one or both of these timeout values needs to 
be increased. If siteVIEW frequently encounters communication errors, it is 
possible that the inter-byte timeout needs to be increased. If these timeout 
values are too high, siteVIEW communication may seem to take an unusually 
long time. Achieving the correct balance of timing values ensures that 
packets are handled efficiently. 

 

Figure 33 – COM Port Panel Component 
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6.3. Devices 

6.3.1. Adding a New Device 

Each Communication Service COM or Ethernet port is capable of 
communicating to a network of hardware devices. To add and configure a 
device for siteVIEW monitoring, first highlight the Port that connects the 
network of hardware devices to the Communication Service and select “Edit-
>New Device” from the main menu. This launches the Device Monitoring 
Wizard. 

First, the device details form will display the device description page. Enter 
the device type and any addressing information and then select next. The 
correct addressing information must be selected in order for proper 
communication to occur.  

Next choose the device name and description. The device name will be used 
by siteVIEW to make reference to the device. The description appears when 
a user hovers over the Site Panel control that represents the device. 

For information about device specific connection parameters, see TASC 
siteCOMMANDER (see Appendix B on page 104), TASC sitePORTAL Lite 
(see Appendix C on page 116), TASC siteRSM device types (see Appendix 
D on page 128) and Ping devices (see Appendix E on page xxx). 

 

 

Figure 34 – Device Monitoring Wizard - Details 
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After entering the device name and description (optional), select the Finish 
button to add the device. siteVIEW will then attempt to communicate with the 
device by polling the device for its status and configuration. If any of the 
communication is incomplete, an indication of this will be displayed in the site 
navigation tree, beside the device’s name. 

siteVIEW will not allow configuration changes to be made on the device until 
the entire device configuration has been successfully downloaded. From that 
point on, siteVIEW assumes that it is the only application that has access to 
the device. If changes are later made to the device using a configuration tool 
such as the sitePORTAL Configuration Utility (SPCU), siteVIEW’s 
configuration for the device will be out of date and this may result in 
erroneous data displayed in siteVIEW. To bring siteVIEW back up to date, 
perform a complete refresh from siteVIEW for the modified device. 

Ethernet devices have an additional connection details setup page. In the 
connection details page enter the IP address, IP port and communication 
timing parameters. 

 

Figure 35 – Device Monitoring Wizard - Identification 
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Note: siteVIEW scope 2.1 is configured with a 3 device maximum. 

6.3.2. Device Details 

 

After communication with a device has been successfully established, additional 
device configuration is made available. Selecting “Edit->Properties” from the main 
menu opens the device details form. The device details form provides the ability to 
configure a device.  

The device details form has multiple tabs. The available tabs differ from device to 
device depending on the device’s firmware version, the available siteVIEW add-ons, 
and the type of device. 

 
Device Uploaded Configuration 

Currently, siteVIEW supports the TASC siteCOMMANDER (see Appendix B 
on page 104), TASC sitePORTAL Lite (see Appendix C on page 116) and 
the TASC siteRSM device types (see Appendix D on page 128) 

When changing a device’s name, please note that existing archived log files 
will still contain the old device name. 

The IP address, IP port and timing parameters can be set for Ethernet 
devices in the communications tab of the device details form. 

WARNING: Making configuration changes to a device will cause the device to 
restart its firmware. As a result the device outputs will turn off. This could 
unintentionally activate/deactivate equipment located at the remote site 
without warning. It is the customer’s responsibility to ensure personnel or 
property is not damaged.  

 

 

Figure 36 – Ethernet Device Connection Details 
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Extra Device Configuration  

Some configuration is stored in siteVIEW and not uploaded into the device. 
The temperature units and the analog formula are extra input configuration 
parameters that are stored in siteVIEW but are not uploaded to the device. 

The temperature units are configurable via the Units selection box on the 
Temperature Inputs tab of the Device Details form. Available temperature 
conversions include Celsius, Fahrenheit, Kelvin, Rankine and Réaumur. The 
default unit value is Celsius. 

Similar to the temperature units, the Analog Input formula are configurable 
via the Formula selection box on the Analog Input tab of the Device Details 
form. The formula values are configurable through the Formula Configuration 
form that can be opened by selecting the Edit button that corresponds to the 
Formula selection box. 

 

Figure 37 – Device Details – Temperature Units Selection 
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Use the Formula Configuration form to add, remove and update various 
analog conversions.   

The formula Name field is the unique identifier of the formula. The formula 
name will appear in the Formula selection field. 

The formula Units field is an optional field that is displayed in the Log Viewer. 

The formula Decimal Places field configures how many decimal places the 
adjusted value should be rounded. 

The formula Equation is used to calculate the value of the analog sensor, 
where x is the input value. See the Formula Configuration form for a 
complete list of accepted equation operators and an example of how to use 
each one. 

The Sample field allows the equation to be tested. This value is input into the 
equation by replacing x and calculating the result. If there are no errors, the 
result is displayed. If there was an error with the formatting then an error is 
displayed. 

  

 

Figure 38 – Device Details – Analog Formula Configuration 
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Once an analog formula has been configured it can be selected and applied 
to any analog input. The analog input’s adjusted high and low threshold 
values will be calculated and displayed. The formula will also be used to 
calculate the analog value whenever a status is returned from the device and 
the calculated value will be displayed in the Log Viewer and on any panel 
controls that represent the analog input. 

 

6.3.3. Ping Devices 

When adding a device to an Ethernet port, there is an option to add a Ping 
device. This device does not have any configuration, or I/O, instead siteVIEW 
can connect to any network device that supports pinging. The device can be 
scheduled to be pinged periodically using scheduled polling.  If an 
unresponsive site alarm is setup for the device, the alarm will trigger 
whenever the site does not respond to a ping. 

 

Figure 39 – Formula Configuration Form 
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6.4. Site Panel 

Each node in the site navigation tree has a panel associated with it. The 
panel contains controls that graphically map out the items available at the 
server, COM port or device. A server’s panel contains controls that represent 
COM ports, a COM port’s panel contains controls that represent devices, and 
a device’s panel contains controls that represent the device’s inputs and 
outputs. Performing a left mouse click on a panel control that represents a 
COM port or a device causes siteVIEW to display the panel for the selected 
COM port or device, essentially traversing the Tree View. Performing a left 
mouse click on a panel control that represents an output causes siteVIEW to 
turn on or turn off the associated output. Panel controls that represent device 
inputs serve as visual indicators of the inputs real life state. 

A user can modify the layout and appearance of the panel and the panel 
controls to give more meaning to the panel. 

6.4.1. Background Properties 

The Site Panel background properties form can be modified in the Panel 
Details form, which is opened by selecting “Edit->Panel->Panel Background” 
from the main menu. The Panel Details form pertains to the currently 
displayed panel. 

The panel height and width affect the total size of the panel. This can be 
different from the actual height and width that the user sees. The panel 
height and width can be set larger or smaller than the actual viewable area of 
the PC screen. 

An image may be set as the panel background by selecting it from the list. 
When an image is selected, a preview of the image is shown in the picture 
box above the image list. To add an image to the list, select the Browse 
button, navigate to the desired image file and select ok. The Rename and 
Delete buttons rename and delete a selected image on the image list. 

 

It is recommended that background images be less than 256KB 
in size. Larger images may take longer to load. 

The mode setting determines how the background image will be fit into the 
background.  

Color sets the panel background color. 
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6.4.2. Panel Control Property Form 

There are several types of panel controls. Individual panel controls may be 
customized to give the control more meaning. Panel controls represent COM 
port connections to sites, devices, contact inputs, analog inputs, temperature 
inputs and outputs. In most cases it makes sense to represent sites and 
devices by a Boolean push button, contact inputs and outputs only have two 
states and so they are best represented by a visual on or off using a 
Boolean, and analog and temperature inputs have ranges and are best 
represented by knobs and slides. 

Selecting the “Edit->Panel->Unlock Panel” from the main menu unlocks the 
currently displayed panel and allows the individual panel controls to be 
modified. While a panel is unlocked, the normal functionality of the panel 
controls ceases. Selecting a panel control opens a form that shows the panel 
control’s display properties. On the top of the panel control display properties 
form is a drop down field of all the controls that belong to the current panel. 
This drop down field, along with the previous and next buttons, is used to 
navigate through the panel controls. 

To select multiple panel controls, left click the mouse at some point on the 
panel, then while holding the left mouse down, drag the mouse over the 
panel controls you wish to select. Multiple controls can also be selected by 
hold the keyboard’s Ctrl button down while left clicking panel controls.  

 

Figure 40 - Background Properties 
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Figure 41 – Selecting Multiple Panel Controls With The Mouse 

 

Figure 42 – Multiple Panel Controls Selected 
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Certain panel control properties are common for all panel control types. 
Other properties are specific to a control type. The Disable User Control and 
confirmation properties are only available if the control it represents is an 
output. When the confirmation property is selected siteVIEW will prompt a 
user for confirmation if the user turns the output on or off. The Disable User 
Control option removes user control entirely. An administrator can set these 
settings accordingly 

The name of the panel control can be changed and shown or hidden using 
the Panel Control Display Properties form. A panel control can be made 
visible or hidden, or it can be deleted completely by selecting the delete 
button. Panel control colors, types and styles are all changed using the panel 
control display properties form. 

6.4.3. Panel Control Types 

Four panel control types are available in siteVIEW. The four panel control 
types are: Boolean, slide, knob and display.

 

Figure 43 – Panel Control Display Properties 



TASC siteVIEW 2.1 User Manual 050-015-0050 R07 

TASC Systems Inc. All Rights Reserved Page 56 of 175 

Boolean 

  

Vertical Toggle 
(VToggle) 
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(HToggle) 

 

Square LED 
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Square Star LED 
(SquareStarLED) 

  

Round LED 
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Round Push Button 
(RoundPushButton) 

 

Square Push Button 
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(ToggleOnOff) 
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Bitmap (Bitmap) 
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Figure 44 - Boolean Styles of Panel Controls 
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Boolean control types are used to represent on and off, or are used as 
buttons. Properties specific to this control type include the off color, off text, 
off text color, on color, on text and on text color. 

 

When Boolean control types are used to represent analog inputs, an “On 
Condition” property becomes available for the control. The on condition 
specifies the conditions when the Boolean control should appear on. When 
these conditions are not met, the Boolean control will appear off. In Figure 46 
– Analog Boolean Control Properties, three Boolean controls are used to 
represent “Analog 01”. The top Boolean control is set to be on when the 
analog’s value is above its high threshold. The middle and selected Boolean 
control is set to appear on when the analog’s value is below the high 
threshold and above the low threshold. The bottom Boolean control is set to 
be on when the analog’s value is below the low threshold. 

 

Figure 45 - Boolean Element Properties 
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Double clicking on the “On Condition” property’s configuration text opens the 
Boolean Control On Condition configuration form. Use this form to select 
when the Boolean control should appear on. 

 

Figure 46 – Analog Boolean Control Properties 

 

Figure 47 - Boolean Control On Condition 
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Knob 
 

Knob control types are used to represent a range of values. Properties 
specific to this control type include the foreground color, format string, axis 
caption, axis maximum and minimum, axis inversion, and the start and end of 

the arc of values. The knob control type is represented as an arc. 

Knob (Knob) 

 

Dial (Dial) 

 

Horizontal Top 
Gauge 
(HTopGauge) 

 

Vertical Right 
Gauge 
(VRightGauge) 

 
Horizontal Bottom 
Gauge 
(HBottomGauge) 

 

Vertical Left Gauge 
(VLeftGauge) 

 

3D Knob (3DKnob) 

 

3D Dial (3DDial) 

 

3D Top Meter 
(3DTopMeter) 

 

3D Right Meter 
(3DRightMeter) 

 
 

3D Bottom Meter 
(3DBottomMeter) 

 

3D Left Meter 
(3DLeftMeter) 

 

Figure 48 - Knob Styles of Panel Controls 
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The format string is discussed in more detail at the end of this section. The 
axis minimum and maximum specify the minimum and maximum values that 
the knob will display. The axis can be inverted so that the numeric scale is 
shown in reverse order. The arc start and end values determine the arc’s 
span. When the arc start and end values are set to –1 a default value is 
used. 

 

 

Figure 49 - Knob Properties 
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Slide 

Slide control types are like the knob control type since they are also used to 
represent a range of values. Properties specific to this control type include 

Vertical 1 (V) 

 

Horizontal 1 (H) 

 

Vertical Pointer 
(VPointer) 

 

Horizontal Pointer 
(HPointer) 

 
Vertical 2 (V2) 

 

Horizontal 2 (H2) 

 

Vertical Bar (VBar) 

 

Horizontal Bar (HBar) 

 
Tank (Tank) 

 

Thermometer 
(Thermometer) 

 

3D Tank (3DTank) 

 

3D Thermometer 
(3DThermometer) 

 
3D Vertical Fill Slide 
(3DVFillSlide) 

 

3D Horizontal Fill 
Slide (3DHFillSlide) 

 

3D Vertical Pointer 
Slide 
(3DVPointerSlide) 

 

3D Horizontal Pointer 
Slide (3DHPointerSlide) 

 

3D Vertical 
Progress Bar 
(3DVProgressBar) 
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Progress Bar 
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3D Horizontal Graduated 
Bar (3DHGraduatedBar) 

 

 

Figure 50 - Slide Styles of Panel Controls 
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the fore color, format string, axis caption, axis maximum and minimum, axis 
inversion. The slide property is represented as a vertical or horizontal line. 

The format string is discussed in more detail at the end of this section. The 
axis minimum and maximum specify the minimum and maximum values that 
the slide will display. The axis can be inverted so that the numeric scale is 
shown in reverse order. 

Display 

Display control types are used to display numeric values using a text string. 
Properties specific to this control type include the fore color and format string.  

 

Figure 51 - Slide Style Properties 

 

Figure 52 - Display Style of Panel 
Controls 
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The format string is discussed in more detail at the end of this section. 

6.4.4. Format String 

The format string that is available in the Panel Control Properties form can be 
used to format the value the user sees.  

Note: The format string is limited in its functionality and should only be used 
to configure the panel control values as they appear on the screen. The values 
that are produced as a result of the format string do not appear in the Log 
Viewer or anywhere else in the system. To format the system value of an 
analog input, configure the Formula value in the Device Properties form (see 
Extra Device Configuration on page 49). 

The following are examples of the variables and components that can be 
used to form a Format String. 

 . (decimal point) - specifies the beginning of the number within the 
label. Use # and 0 to the right of the decimal point to specify the 
precision. If you do not include a decimal point in the format string, a 
decimal point is assumed to be the first character in the format string 

 0 - specifies the precision to the right of the decimal point. For 
example, ".#0" always produces two digits to the right of the decimal 
point, even when given an exact number such as 1.0 

 # - specifies the precision to the right of the decimal point. For 
example, ".##" produces up to two digits to the right of the decimal 
point. Thus, 1.0 produces 1, while 1.025 produces 1.03 

 e, E - specifies exponential notation. "E" specifies the capital letter, 
while "e" specifies the lowercase letter 

 *nn - scales labels. For example, ".*10" prints the value 1.0 as 10 

 

Figure 53 - Display Style Properties 
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 +nn or -nn - offsets labels. For example ".+20" prints the value 1.0 as 
21 

 k - specifies symbolic notation. For the format string ".k", 1.0 prints as 
1, 1000 prints as 1k, and .001 prints as 1m 

 "text" - specifies to add text to the label. For example, '."V"' adds a V 
to the right of every label. Thus, 1.0 becomes 1 V 

 $, % - specifies to print these special characters 

 

The following are two useful format string examples: 

 Celsius to Fahrenheit Conversion 

Note that this conversion is not necessary if your temperature sensor is 
already set up to use Fahrenheit units, however this example demonstrates 
how to use the format string. 

Using the equation ºF = (1.8) ºC + 32 to calculate the Fahrenheit value, a 
format string of *1.8 +32 would be used and would result in the following: 

 

 Adding Text 

 

Figure 54 - Celcius to Fahrenheit Conversion 
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Using the previous example for converting Celsius to Fahrenheit, adding the 
string "°F" to the format string would become *1.8 +32 "°F" and would result 
in the following: 

Note: To add a degree symbol ( ° ) to your format string, hold the ALT key 
down and type the number 0176, or refer to the “Character Map” to look for 
special characters to copy and paste into siteVIEW. The “Character Map” is 
included with the Microsoft Windows operating system and can be accessed 
from the windows start menu by selecting “Program–>Accessories–>System 
Tools->Character Map”. 

 Fahrenheit to Celsius Conversion 

To convert Fahrenheit to Celsius using the equation ºC = (ºF – 32) / 1.8, the 
format string would be –32 *0.5556, where 0.5556 is the inverse of 1.8. 

Note: There is no division operator available with the format string field. So the 
user must take the inverse and multiply. Also there must not be any space 
between the operator and the number, so if you want to add 32, you must write 
+32, and not + 32. Lastly, you cannot use operators more than once, so you 
can write *1.8 +32, but if you write +4.2 *1.8 +32, the first value is ignored. 

6.4.5. Adding Controls to a Panel 

It may be useful to have multiple components on a panel that represent the 
same input or output. For example, it may be useful to show an analog or 
temperature value as a dial or thermometer, and at the same time have a 
text representation of the same information.  

 

Figure 55 - Adding Text to Format String 
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To add controls to a panel, first unlock the panel by selecting “Edit->Site-
>Unlock Panel” from the main menu. While the Site Panel is unlocked, select 
“Edit->Site->Add Panel Control” to open the “Add Panel Control” form. 
Ensure the control is being added to the correct panel, then choose an input 
or output from the I/O list and select the add button. 

The new control will appear in the top left corner of the panel. Move the 
control to the desired location and change the control properties as needed.  

It may be useful to have two panel controls representing the same output. By 
disabling user control on one of the outputs, the disabled control will show 
the actual device value. Whereas the control that allows user control would 
be out of sync with the device starting from the time a user changes the 
output until the device response is received. 

 

Figure 56 - Adding I/O to a Panel 

 

Figure 57 - Panel Control Properties 
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6.4.6. Panel Import and Export 

A panel may be exported to a file and re-imported later into the same panel 
or into a different panel. If any differences exist between two panels, those 
differences are ignored. For example, if a panel file that contains a 
temperature input control is imported into a panel with no temperature input 
to match, the resulting panel will not contain a temperature input control. The 
import and export functionality can be accessed by selecting “Edit->Panel-
>Import Panel” and “Edit->Panel->Export Panel” respectively. 

 

6.5. Alarm Conditions 

Alarm conditions can be configured for individual inputs, outputs, or devices. 

Alarm conditions can also be configured to alarm when a device is 
unresponsive. 

A user can then manage alarms by taking necessary actions as defined by 
procedures or the instructions associated with the alarm. 

6.5.1. Alarm Condition States 

Alarm conditions set boundaries for inputs or outputs, allowing the user to be 
notified when the value goes outside this boundary. When the value is 
outside the alarm condition’s boundary, the alarm has then been triggered 
and the user is notified.  

Users can acknowledge and clear alarms, hence possible alarm status 
values are Ceased, CeasedAndAcknowledged, CeasedAndCleared, Active, 
ActiveAndAcknowledged and ActiveAndCleared. 
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6.5.2. Configuring an Alarm Condition 

To configure an alarm, select a tree node under the “Network” node. 
Selecting a tree node under the “Groups” node will result in a read only view 
of configured alarm conditions. 

Selecting “Edit->Alarm Configuration” from the main menu opens the alarm 
configuration form. From this form a user can create new alarm, and delete 
or modify existing ones.  

When creating an alarm, ensure the server, COM port, device and device I/O 
are selected correctly. Changes made to the alarm configuration form do not 
take effect until the update button is selected or add is selected while 
creating a new alarm condition. 

The alarm severity is used to place importance and priority on alarms.  Three 
alarm severity options exist: Minor, Major and Critical. Minor alarms are the 
least severe and Critical alarms are the most severe. The different alarm 
severities are color coded in the alarm status panel. By default active critical 
alarms appear red, active major alarms appear orange and active minor 
alarms appear yellow. Ceased, acknowledged and cleared alarms appear 
grey in color. These colors are configurable (See Global Alarm Notification 
Settings, section 6.5.3 on page 76, for information on how to change alarm 
severity colors). 

 

Figure 58 – siteVIEW Alarm Condition States 
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An alarm can be enabled or disabled by changing the Enabled option. 

The type and number fields indicate the input or output the alarm condition 
applies to.  

The alarm conditions for a contact input or an output have only two choices 
and that is On or Off. In other words an alarm can be set to trigger when the 
input or output is on or when it is off. 

The analog or temperature input alarm conditions are based on the low and 
high thresholds of the device’s input, which are configured through the device 
details form and displayed as read-only fields in the alarm configuration form. 
When an input’s value crosses one of its thresholds, the device then notifies 
siteVIEW of the change. The alarm can be triggered if the input’s values go 
above a threshold, below a threshold or the threshold change can be 
ignored.  

To configure an non-responsive device alarm, select the desired device and 
select no I/O. Then whenever the device does not respond to a request from 
siteVIEW, the alarm will trigger. The non-responsive site alarm does not 
cease until a successful request/response transaction occurs. An non-
responsive device alarm also triggers when the device’s port or computer 
becomes unavailable. Disabling a port or device does not cause an non-
responsive device alarm.  

The alarm details are useful for providing instructions to the user when the 
alarm occurs. 

The list on the bottom of the alarm configuration form displays alarm 
conditions. Select an entry from the list to see the alarm condition details. If 
an alarm condition does not appear on the alarm condition list, ensure the 
filter is selected correctly. 

 

Figure 59 - Alarm Configuration Form 
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6.5.2.1. Analog and Temperature Sensor Alarm Conditions 

Unlike Digital Inputs/Outputs and Device (Non-Responsive) alarms, Analog 
and Temperature sensor alarm conditions can be set configured in multiple 
ways: 

 

 

Case 

Low Condition 
Setting 

High Condition 
Setting 

Comment 

A LT (Less Than) GT (Greater Than) Used for “exclusionary” alarm zones 

B LT LT Note: Only High condition is considered 

C LT Ignore Single alarm condition 

D GT GT Note: Only Low condition is considered 

E GT LT Used for “inclusionary” alarm zones 

F GT Ignore Single alarm zone 

G Ignore GT Single alarm zone 

H Ignore LT Single alarm zone 

I Ignore Ignore Note: No alarm conditions considered 

 

6.5.1. Alarm Management 

Alarms may be managed using siteVIEW interface options. 

6.5.1.1. Show Cleared Alarms 

Upon startup of siteVIEW, the “Show Cleared Alarms” option, available in the 
Alarm list, is enabled. This flag determines if Active and Cleared alarms are 
displayed. 

 

 

Figure 60 – Alarm Management 

Show Cleared Alarms 
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6.5.1.2. Clear All Reported Alarms 

From the Alarm list, use “Clear All Alarms” to clear all active and ceased 
alarms. 

6.5.1.3. Clear a Selected Alarm 

From the Alarm list, use “Clear Alarm” to clear a specific alarm from the 
alarm list. 

 

Figure 61 – Alarm Management 

Clear All Alarms 

 

Figure 62 – Alarm Management 

Clear a Selected Alarm 
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6.5.1.4. Acknowledge a Selected Alarm 

From the Alarm list, use “Acknowledge Alarm” to acknowledge a specific 
alarm from the alarm list. 

6.5.1.5. Clear All Alarms for a Device 

From the Sites tree, select a device and use “Clear All Alarms for Device” to 
clear all active alarms for the selected device. 

 

Figure 63 – Alarm Management 

Acknowledge a Selected Alarm 

 

Figure 64 – Alarm Management  

Clear All Alarms for a Device 



TASC siteVIEW 2.1 User Manual 050-015-0050 R07 

TASC Systems Inc. All Rights Reserved Page 73 of 175 

6.5.1.6. Clear All Ceased Alarms 

From the Alarm list, use “Clear All Ceased Alarms” to clear all ceased 
alarms. This will return the alarm condition to “Ceased and Cleared” or 
normal state. 

6.5.2. Alarm Specific Reporting Options 

Selecting the notification button opens the Alarm Reporting Options form. 
The alarm condition specific options can be configured from the Alarm 
Reporting Options form. 

 

Sounds 

Selecting the sound tab from the Alarm Reporting Options form allows the 
selected sound and play interval to be changed. The selected sound file will 
play on the event the alarm is triggered.  

If an alarm is selected the sound interval can be changed. The play interval 
determines the length of time siteVIEW will wait before replaying the sound 
file. 

 

Figure 65 – Alarm Management 

Clear All Ceased Alarms 
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From the sound tab, sound files may be deleted, renamed or sampled, and 
new sound files may be loaded. siteVIEW is capable of playing most 
common sound file types including wave (.wav), midi (.mid), mpeg layer 3 
(.mp3) and windows media audio (.wma). 

 

Text to Speech 

Selecting the “Text To Speech” tab from the Alarm Reporting Options form 
allows the spoken message and play interval to be changed. The specified 
text string will be spoken through the client PC’s speakers in the event the 
alarm is triggered. 

The play interval determines the length of time siteVIEW will wait before  
 replaying the message. 

 

Figure 66 – Alarm Sound 
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Recipients 

Recipients are users who receive notification of the alarm. Selecting the 
“Recipients” tab from the Alarm Reporting Options form allows the selected 
alarm recipient list to be updated. The selected recipients will be notified 
when an alarm occurs. The User’s notification options are configured from 
the “User Administration” form (see Managing User Accounts, section 5.1, on 
page 37). 

If the Notify SNMP Agent is selected, the SNMP Manager will be notified 
when the alarm occurs. The SNMP Manager is configured within the Global 
Alarm Notification settings area. 

 

 

 

Figure 67 –Text to Speech 

 

Figure 68 - Alarm Recipients 
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6.5.3. Global Alarm Notification Settings 

By default, when an alarm is cleared, it no longer shows in the alarm panel. 
However, by selecting “View->Show Cleared Alarms” from the main menu, 
you may show or hide cleared alarms. 

Selecting “Tools-> Notification Settings” from the main menu opens the 
Notification Configuration Form. From this form, global alarm notification 
options may be set that apply to all alarm conditions. 

 

Display Settings 

Selecting the “Display Settings” tab allows a user to change the alarm panel 
colors for the different alarm severities. 

 
Email 

Email alarm notifications are only available if the security key has been 
configured to allow Email as a siteVIEW option. However, the email page is 
still available even if email is not enabled in the system for password 
recovery purposes. Specify an SMTP server that will serve as the default 
SMTP server during password recovery. 

Selecting the “Email” tab allows a user to configure the outgoing email 
server, the retry interval, the default email message template and the default 
recipient email addresses. This form also allows the user to test the email 
reporting system by sending test emails. 

 

Figure 69 – Notification Configuration – Display Settings 
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The outgoing mail SMTP Server is the email server that will be used to send 
email. This can be any SMTP server that the Alarm Notification Handler has 
access to. If the server resides on the same computer as the Alarm 
Notification Handler, then the server can be set as “localhost” or “127.0.0.1” 
or even the DNS name of the computer the Alarm Notification Handler 
resides on. A remote server can also be specified. 

The outgoing mail name is the sender name that will appear on all out going 
emails from siteVIEW. A valid From email address must also be supplied for 
the SMTP server to authenticate that the email is being sent from a valid 
email account. 

 

To use siteVIEW with third party email services which require a 
secure connection, ensure that Enable SSL is selected and the 
specific port number is appended to the Server (SMTP) name. 

For example, to use Google’s Gmail service, Server (SMTP) 

would be smtp.gmail.com:587 and the Enable SSL option 

would be checked. 

The email test section allows a user to test the outgoing mail configuration by 
sending a test email to a specified email address. 

The default recipient email addresses allows for system wide emails to be 
sent based on the criticality of the alarm that initiated the email. Each 
criticality can have one or more email addresses separated by a comma or a 
semi-colon. 

 

Figure 70 – Notification Configuration – Email 
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The retry interval indicates how often the email will be resent. The email will 
continue to be sent to the recipient until the alarm has ceased or been 
acknowledged or cleared. 

Pressing the “Edit” button opens the Notification Message editor. From the 
Notification Message editor, the siteVIEW alarm notification email can be 
modified. The left side of the form can be edited and the right side of the form 
displays an example of what the alarm email will look like. A column of 
buttons is located down the center of the form. When any of the buttons are 
pressed, a predefined field tag is inserted into the message. For example, 
pressing the button labeled “Alarm ID” inserts the alarm id tag into the 
message in the form of “<ALARM_ID>.” This tag is a placeholder that gets 
replaced with the actual alarm id before the email is sent. 

 

Figure 71 – Default Email Message Editor 
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Pager Settings 

Note: Paging is only available if the security key has been configured to allow 
paging as a siteVIEW 2.1 option and it is only available as an option in a 
siteVIEW Enterprise 2.1 system.  

Selecting the “Pager” tab allows a user to configure the outgoing pager 
modem line, the retry interval, the numeric paging message and the default 
recipient pager numbers. This form also allows the user to test the pager 
reporting system by sending test pages. 

 

The outgoing modem line is the modem line that will be used to send pages. 
This can be any modem line that is configured on the Alarm Notification 
Handler computer. 

The pager test section allows a user to test the outgoing pager configuration 
by sending a test page to a specified phone number. 

The default recipient pager numbers allows for system wide pages to be sent 
based on the criticality of the alarm that initiated the page. Each criticality can 
have one or more pager numbers separated by a semi-colon. 

 

Figure 72 – Notification Configuration – Pager Settings 
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Note: Do not use a comma to separate pager numbers, as a comma is 
used to indicate a pause when dialing a number. 

The retry interval indicates how often the page will be resent. The page will 
continue to be sent to the recipient until the alarm has ceased or been 
acknowledged or cleared. 

 

FleetSync Settings 

Note: FleetSync is only available if the security key has been configured to 
allow FleetSync as a siteVIEW 2.1 option and it is only available as an option in 
a siteVIEW Enterprise 2.1 system.  

Selecting the “FleetSync” tab allows a user to configure the outgoing 
FleetSync notification options. 

 

 

 

Figure 73 – Notification Configuration – FleetSync Settings 



TASC siteVIEW 2.1 User Manual 050-015-0050 R07 

TASC Systems Inc. All Rights Reserved Page 81 of 175 

SNMP Settings 

Note: SNMP is only available if the security key has been configured to allow 
SNMP as a siteVIEW 2.1 option and it is only available as an option in a 
siteVIEW Enterprise 2.1 system.  

The SNMP notification feature allows siteVIEW to send a SNMP v2 Trap to a 
SNMP-capable manager – for example, a Network Operations Center 
software system. 

Selecting the “SNMP” tab allows a user to configure the outgoing SNMP 
notification options. 

 

 

The SNMP - Settings section defines the SNMP Manager’s location in terms 
of Address and Port number. Use the MIB dropdown to select the SNMP MIB 
file to be used. 

To test SNMP trap, use the SNMP – Test Trap section’s Send button. 

 

 

Figure 74 – Notification Configuration – SNMP Settings 
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6.6. Automated Polling 

Automated Polling is used to check the status of selected devices within the 
network at scheduled intervals. This is used to ensure that conditions at 
remote locations remain within acceptable parameters. 

To configure polling, select a tree node under the “Network” node. Selecting 
a tree node under the “Groups” node will result in a read only view of 
configured polling. 

Selecting “Edit->Polling Configuration” from the main menu opens the polling 
configuration form. From this form a user can create polling schedules, and 
delete or modify existing ones.  

Changes made to the polling configuration form do not take effect until 
Update is selected after making changes to an existing polling schedule or 
add is selected while creating a new polling schedule. 

A scheduled poll tells siteVIEW to communicate with a device at a specified 
time. The type of communication depends on the type selected. Available 
scheduled poll communication types are: 

 DeviceStatus: retrieves the device status. This ensures that siteVIEW 
has not lost communication with the device. Also it allows siteVIEW to 
detect if any device configuration has changed. If a change in device 
configuration is detected, siteVIEW will automatically download the 
new configuration settings. 

 DeviceStatus is also the option to choose for pinging a device. 
siteVIEW will then ping for the device’s status. 

 AllContactInputs: retrieves the contact input values. 

 

Figure 75 - Polling Configuration Form 



TASC siteVIEW 2.1 User Manual 050-015-0050 R07 

TASC Systems Inc. All Rights Reserved Page 83 of 175 

 AllTemperatureInputs: retrieves the temperature input values. 

 AllOutputs: retrieves the output values. 

 AllAnalogInputs: retrieves the analog input values. 

 MinMaxLogCount: retrieves the min/max log count. If the returned 
value is more than zero, siteVIEW will automatically download and 
clear the min/max log. 

 SampleLogCount: retrieves the sample log count. If the returned 
value is more than zero, siteVIEW will automatically download and 
clear the sample log. 

 RealTimeClockRam: retrieves values stored in the real time clock 
(RTC) random access memory (RAM). The data logger timers are 
stored in the RTC RAM. 

A scheduled poll has an interval. This interval specifies how often the 
scheduled poll is to occur. An interval of every two hours will cause the 
scheduled poll to occur every two hours for the selected days, starting from 
the start date and ending on the end date. The scheduled poll end date can 
be set to never end by removing the end date option. If the selected interval 
is in minutes or hours, an end time may be specified. If an end time is 
specified but no end date is specified, the scheduled poll will occur 
indefinitely but only between the specified times each day. An end time 
cannot be specified if the time interval specified is day, week, month or year. 

Scheduled polls without the Enabled option selected will not occur, but can 
be re-enabled by selecting the Enabled option and then selecting Update. 

In order for a scheduled poll to occur, at least one device must be assigned 
to the scheduled poll. There are two list-boxes in the scheduled poll form, 
each showing a list of Communication Services, along with the 
Communication Service’s COM ports and the devices connected to those 
COM ports. The Excluded list contains devices that will not be included in 
this scheduled poll; whereas the Included list contains devices that will all be 
polled at the scheduled time. After including or excluding devices in the 
scheduled poll the update button must be selected in order to Update the 
schedule poll. 

Deleting a scheduled poll permanently deletes the scheduled poll for all 
devices associated with the scheduled poll. 

The list on the bottom of the scheduled polling configuration form lists 
existing scheduled polls. Clicking on an entry in the list shows the schedule 
details. If a scheduled poll does not appear on the scheduled poll list, ensure 
the device filtering options are selected correctly. 

6.7. Site Mapping 

To configure site mapping, select a tree node under the “Network” node. 
Selecting a tree node under the “Groups” node will result in a read only view 
of site mapping. 
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Selecting “Edit->Site Mapping Configuration” from the main menu opens the 
site mapping configuration form. From this form a user can map outputs to 
any other input or output which is monitored by siteVIEW. The site mapping 
configuration form is also used to delete or modify existing mappings.  

Changes made to the site mapping configuration form do not take affect until 
update is selected after making changes to an existing output mapping or 
add is selected while creating a new output mapping. 

An output mapping tells siteVIEW to turn on or turn off a specified output 
based on the result of some other input or output in siteVIEW.  

WARNING: Site Mapping cannot occur if siteVIEW loses its connection to the 
mapped device. If the target device is unreachable then no output event can 
occur. 

The input condition is specified for a specific server, COM port, device and 
input or output on that device. When the input or output condition occurs, 
siteVIEW is then to take the specified output action. An input condition can 
occur when an input or output is turned on or off, or an input condition can 
occur when an analog or temperature value is less than or greater than one 
of its thresholds. 

The site mapping condition form allows a user to modify, delete and enable 
or disable site mappings. 

The list on the bottom of the site mapping configuration form displays site 
mappings. Select an entry from the list to see the site mapping details. If a 
site mapping does not appear on the site mappings list, ensure the filter is 
selected correctly. 

 

Figure 76 - Site Mapping Configuration Form 
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6.8. User Access 

Selecting “Edit->User Access” from the main menu opens the User Access 
configuration form. The User Access form is only viewable by an 
administrator. The User Access form allows administrators to restrict access 
of other users to parts of the system. This way different users can be 
assigned to different parts of the system and can only see the parts that they 
are assigned to.  

By default, all users have access to different parts of the system and they 
must be manually denied access to various parts of the system. 
Administrator users cannot be given restricted access and so they will always 
have access to all parts of the system.  

 

Figure 77 – User Access Configuration 
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7. MONITORING AND CONTROLING DEVICES 

Once devices are configured they are ready for monitoring and control. 
Monitoring and control using siteVIEW includes viewing the current status of 
devices, controlling device outputs and responding to alarms. 

siteVIEW does not exit completely when the siteVIEW user interface is 
closed (by selecting the close button in the top right corner of the main 
application form). Instead siteVIEW is minimized to the system tray. To exit 
the siteVIEW user interface completely, select “Connect->Exit siteVIEW” 
from the main menu. Once siteVIEW is closed, the Data Handler, 
Communication Service and Alarm Notification Handler continue to function. 
Communication with the configured sites, auto polling, site mapping and new 
status information returned from the device all continue to occur even though 
the user interface has been closed. 

Note: Even though the User Interface may be closed, monitoring, alarm 
reporting, scheduled polling and Site Mapping continue to occur for the rest of 
the User Interfaces connected to the Data Handler 

7.1. Device Inputs and Outputs 

siteVIEW can monitor several types of inputs and outputs. Those inputs and 
outputs can be represented in different meaningful ways. 

Panel control outputs can be turned on and off, but inputs cannot be 
changed. Outputs may be controlled if the user has the required access 
rights.  

Warning: When controlling outputs, the value displayed on the panel 
will be different than the actual output value while the command is 
being sent. 
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7.2. Alarm Handling 

Alarm conditions pertain to input and output values. When an alarm condition 
occurs, an alarm is triggered and the siteVIEW user is notified in several 
ways. Visually, the affected input or output Panel Component will blink on 
and off, the associated navigation tree node displays an alert icon and an 
alarm is added to the alarm panel. 

WARNING: the 3DCommandOk and 3DToggleOnOff Boolean control styles do 
not blink during an alarm condition. 

 

Figure 78 - Site Panel Example 

 

Figure 79 - Alarm Pop-Up Notification 



TASC siteVIEW 2.1 User Manual 050-015-0050 R07 

TASC Systems Inc. All Rights Reserved Page 88 of 175 

If siteVIEW is minimized when an alarm occurs, the siteVIEW system tray 
icon will display a blinking alert icon and an alarm pop-up screen is displayed 
above the siteVIEW system tray icon, in the bottom right area of the screen. 
The pop-up screen can be displayed manually from the main menu by 
selecting “View->Show Alarm Pop-up Window.” 

If the triggered alarm has a sound file associated to it, the sound file will play 
while the alarm is active or until the user mutes the alarm sound. 

The alarm popup form displays a summary of active alarms. Whereas the 
alarm panel displays all active and inactive alarms that have not been 
cleared. Each entry of the alarm popup form and each entry on the alarm 
panel have a find button with a question mark on it. Selecting the find button 
navigates the user to the device where the alarm occurred, and the device 
panel is displayed. 

Each alarm entry on the alarm panel and alarm popup displays information 
about the input or output where the alarm has occurred. Performing a double 
mouse click on an alarm panel entry displays the alarm details form. 

The Alarm Details form gives details of the alarm location, the time the 
alarm’s status last changed and details about the alarm. The Details field is 
useful for providing instructions to a user in the event that the alarm is 
triggered. 

If an alarm has a sound file associated to it, selecting the mute button stops 
the sound from playing until the alarm has been triggered again. The snooze 
button causes the alarm sound to stop and not resume again until five 
minutes later. If within those five minutes the alarm condition ceases, the 

 

Figure 80 - Alarm Details Form 
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snooze is interrupted and the sound will not occur again until the next time 
the alarm is triggered. 

The status of the alarm is displayed in the status field. A user can change the 
status of the alarm by selecting an action and then selecting the Set button. 
Active alarms can be cleared or acknowledged. Acknowledging an alarm 
causes the alarm to remain in the alarm panel, but all other alarm indications 
stop. Clearing an alarm removes the alarm from the alarm panel completely. 
But selecting “View->Show Cleared Alarms” causes cleared alarms to be 
displayed on the alarm panel as well. 

Alarm panel entries have different colors based on the alarm severity and 
status. Critical alarms appear with a red background, major alarm 
backgrounds are orange and minor alarm backgrounds are yellow. When an 
alarm has become inactive or when an alarm is cleared, the alarm panel 
entry background turns grey. The background of an active alarm blinks when 
the alarm is neither acknowledged nor cleared. 

7.3. Manually Polling the Devices in the Network 

Options exist that allow a user to manually initiate a poll. This allows the 
operator to retrieve the current status of the selected unit at any time. To 
perform a manual poll select one of the “Edit->Manual Poll” submenus. 
Selecting the manual poll button on the tool bar can access the same 
functionality. 

Selecting “Edit->Manual Poll->Status Refresh” causes siteVIEW to retrieve 
the status and I/O values of all devices under the currently selected node.  

For instance, if a Server node is selected then all COM Ports and their 
respective devices will be polled. 

If a COM Port Node is selected then all devices within that COM Port will be 
polled. 

If a device node is selected then only that particular device will be polled. 

 

Figure 81 - Manual Poll Options 
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A status refresh retrieves a device’s status and I/O values. A configuration 
refresh retrieves the device’s configuration settings. A full refresh performs 
the functionality of a status refresh and a configuration refresh combined. 
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8. LOGGING 

Each time an alarm occurs, or an I/O value changes or communication with a 
device occurs, siteVIEW records the event in a log. This is known as 
siteVIEW logging.  

Some devices also have logging of their own. This kind of logging is referred 
to as device logging. Device logging is currently only available for the TASC 
siteCOMMANDER device type and is not visible in systems that are not 
configured to support siteCOMMANDERs. 

The log viewer can be viewed by selecting “View->History” from the main 
menu or by selecting the history button from the toolbar.  

The log viewer connects to the logging interface, which resides on the Data 
Handler computer.  

The log viewer form displays log entries on the right and a list of log types on 
the left. 

 

Figure 82 - siteVIEW Log Viewer 
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From the menu links of the log viewer form a user can export, clear or refresh 
log entries. The log data can be filtered and archived, and any data can be 
exported to xml. 

A list of archived logs is shown on the bottom left of the Log Viewer. Select 
an archived log to view it in the Log Viewer or delete it. Logs are 
automatically archived to prevent the logs from becoming unmanageably 
large.  

 

8.1. siteVIEW Logging 

Each time an alarm’s status changes an entry for the alarm is recorded in the 
alarms log. The alarm log also contains a field named Username. This field 
records the user who changed the alarm status. If the Username field is 
empty, then the alarm status was changed automatically by the system. 

Each time communication occurs between siteVIEW and a device, the 
communication is recorded in the communications log.  

Each time an I/O value is returned from a device, an entry is recorded in the 
I/O values log that indicates this value. 

siteVIEW also records each time a user logs in or out of the siteVIEW system 
in the access log, however, this log can only be viewed by an administrator. 

8.2. Device Logging 

Device logging is only available for the TASC siteCOMMANDER device.  

A siteCOMMANDER may be set up to perform logging locally. If device 
logging is enabled for a siteCOMMANDER, it can be manually retrieved or 
automatically retrieved by siteVIEW by setting up an automated poll. To 
retrieve a device’s log manually, select a siteCOMMANDER’s device node 
on the navigation tree and then select “Edit->Data Logger” from the main 
menu. This will open the device data logger form. 

The first time the device data logger form is opened for a device, most of the 
information will be unavailable. There are two refresh buttons on the device 
data logger form that allow a user to refresh the logger information. If the 
data logger is running, the data logger information will constantly change at 
the device and siteVIEW will not be aware of the changes without performing 
another refresh. 

A user can download the sample log or the min/max log and when the 
download has completed, siteVIEW automatically clears the log that was 
downloaded. Or a user can manually clear the log without downloading the 
values. 
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The data logger can be stopped and started from the device data logger 
form. The time the logger was started is displayed in the field labeled start 
time. 

Several timers exist in the device Data Logger form. These values are not 
stored in the data logger and they cannot be automatically downloaded. The 
timers are only available for viewing through the device data logger form. The 
timers display the total accumulated time the carrier operated squelch (COS) 
was active, if the device is a siteCOMMANDER equipped with the FFSK 
option, and accumulated time the inputs were on. The last update time 
displays the last time these values were updated. 

8.3. Log Viewer Properties 

You can access the Log Viewer Properties page by selecting the options link 
from the Log Viewer form. 

8.3.1. Log Archiving 

By default logs available from the Log Viewer are automatically archived 
every evening at midnight by the Logging Interface.  The length of time to 
keep a log entry before archiving is adjustable, as are the auto-delete 
options. 

The log archives are saved to “<InstallDir>\data\Archive”, where <InstallDir> 
is the installation path of the Data Handler (by default, <InstallDir> is 
“C:\Program Files\TASC\siteVIEW 2.1\ DataHandler”). The amount of 
computer hard drive space the Logging Interface needs to maintain these 
archives ranges greatly, depending on the amount of activity in the system 
and how long the archives are stored, so please monitor these files to make 
sure the computer does not run out of space. 
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Figure 83 - siteVIEW Log Viewer - Options 



TASC siteVIEW 2.1 User Manual 050-015-0050 R07 

TASC Systems Inc. All Rights Reserved Page 95 of 175 

9. SYSTEM ARCHIVE AND RESTORE 

The stored data and logs can be archived and restored. To access the 
archive and restore options, select “Tools->System Archive/Restore” from the 
main menu.  

9.1. Automated Archive 

To setup automated system archiving, check the enabled checkbox, setup 
the path on the server where to archive to and set up a schedule.  

9.2. Manual Archive & Restore 

System archives can be archived manually by selecting an archive name and 
selecting the archive button. The archive will automatically be saved into the 
default archive directory. 

To manually restore a stored system archive, select an available archive 
from the list and then select restore. 

 

 

Figure 84 – Automated System Archive 
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Archives that were stored in previous versions of siteVIEW will be 
automatically updated to the newer version when the archive is restored. 

 

Figure 85 – Manual System Archive & Restore 
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10.  TROUBLESHOOTING 

10.1. Event Viewer 

TASC siteVIEW uses the Windows operating system’s Event Viewer to track 
when the Data Handler stops and starts. The Event Viewer is also used to 
track key information such as licenses and add-ons, and to track Data 
Handler application errors. 

To access the Windows Event Viewer, select Administrative Tools from the 
Windows Control Panel. Under administrative tools, select Event Viewer. The 
TASC siteVIEW event log is specific to TASC siteVIEW 2.1. 

The Event Viewer can be used to help troubleshoot problems with the 
security key, notification errors (e.g., email server problems) and Data 
Handler connectivity problems. 

10.2. Communication Service Log Files 

10.2.1. Message Transaction Log Files 

The Message Transaction log file provides high-level operational information 
for the siteVIEW Communication Service software module, including: 

 Message requests and responses from siteVIEW (Data Handler) 

 Overall health of all underlying communication ports 

 

By default, the CommunicationService.log file is disabled. To enable the 
CommunicationService.log file:  

 Navigate to the C:\Program Files (x86)\TASC\siteVIEW 

Enterprise Edition 2.0\CommSvc directory  

 Use a text editor to edit the CommunicationService.exe.config 

configuration file  

 Add the following line before the </appSettings> line:  
<add key="CommunicationServiceLogging" value="True" />  

 Save the file  

http://en.wikipedia.org/wiki/Event_Viewer
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 Use the TASC Communication Service Utility to restart the 
CommunicationService  

 
 
 

10.2.1. Port Transactions Log Files 

For each COM port, a TransmitReceiveCOMxxx.log file (where xxx is the 
COM port number) is created in the C:\<Program Files>\TASC\siteVIEW 

Enterprise Edition 2.0\CommSvc directory to track communication 

transactions. 

The port transaction log files are created and update automatically. In 
addition to transactions, the state, availability and the connection status of 
the port is provided. 

 
 
 

 

 

 
 

Figure 86 – Sample Message Transaction Log File 

 

 

Figure 87 – Sample Port Transaction Log File 
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10.3. Solutions to Problems 

I cannot sign into siteVIEW because there are no licenses available 

 

 Look in the event viewer and ensure the Data Handler properly 
detected the key and its licenses. 

 It may be possible the Data Handler is not properly detecting the 
security key for some reason. Stop the Data Handler using the Data 
Handler Utility and then exit the Data Handler Utility completely by 
minimizing it and then closing it once it minimizes to the system tray. 
Then use the “Safely Remove Hardware” program, which is also 
located in the system tray to remove the siteVIEW USB Key. Once 
the key is uninstalled, remove the key manually and then reinsert the 
key. Make sure the key is inserted completely. The siteVIEW USB 
Key should then reappear on the list of installed hardware. Then 
restart the Data Handler Utility by selecting “Start->Programs->TASC-
>Data Handler Utility.” Then using the Data Handler Utility, start the 
Data Handler. 

 Sometimes the siteVIEW USB Key is removed improperly and then 
the computer must be restarted before the system will properly detect 
the security key again. 

 

siteVIEW will not detect my key 

 

 Ensure the key is properly inserted into an available USB connection 
on the computer where the Data Handler resides. Do not remove the 
key at any time while the Data Handler is running. 

 If the key is properly inserted and siteVIEW still does not detect the 
key, remove the key and restart the computer. Once the computer 
has restarted then insert the key and allow the operating system to 
find and install any drivers it needs. Once the operating system has 
detecting the key, siteVIEW should function properly. 

 

The Communication Service is not running 

 

 Use the Communication Service Configuration Tool to start the 
Communication Service. Several Communication Services can be 
installed on different computers and each Communication Service is 
installed with its own configuration tool.  

 

The Alarm Notification Handler is not running 

 

 Use the Alarm Notification Handler Configuration Tool to start the 
Alarm Notification Handler.  
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I cannot make changes to the system 

 

 Ensure the login user you are using has the appropriate rights to 
access the siteVIEW features you wish to use. 

 

siteVIEW is unable to make a connection to a device 

 Ensure the device addressing is correct, otherwise siteVIEW will not 
be able to connect to the device. 

 Ensure the device is connected properly. 

 If using an Ethernet to serial connection to connect to the device, 
check that the virtual serial communications port is setup properly in 
the Lantronix CPR Manager application. 

 

siteVIEW tells me the COM port is already in use 

 

 Ensure no other applications are using a COM port that siteVIEW is 
expecting to use for monitoring. Once an application is closed and the 
COM port is freed up again for siteVIEW to use, select “Edit-
>Properties” for the COM port that had difficulties, and then select the 
refresh button to allow siteVIEW to resume monitoring on the COM 
port. 

 

I cannot connect to the Data Handler 

 

 Ensure the Data Handler you are trying to connect is visible to the 
computer you are trying to connect from. Make sure the Data Handler 
listen port is not in use by another program. 

The Log Viewer Does not work properly 

 Using the Data Handler Utility, ensure the logging interface service is 
running and make sure the logging interface listen port is not in use 
by another program. 
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APPENDIX A. TASC HARDWARE & FIRMWARE 

A.1. Overview 

The TASC siteCOMMANDER (sC), sitePORTAL Lite (sPL) and siteRSM 
(sRSM) all use the same hardware but are different by their application 
firmware. This common hardware is known as the TASC TRIO. 

The TASC TRIO has eight analog inputs, eight contact inputs, eight digital 
outputs and has room for up to eight temperature sensors. 

The siteRSM and sitePORTAL Lite hardware devices are capable of adding 
digital and analog expansion boards. They are caplable of adding a total of 4 
digital expansion boards, each with 8 additional contact inputs, allowing for a 
maximum of 40 contact inputs (32 expansion and 8 on-board). And these 
boards are capable of adding a total of 2 analog expansion boards, each with 
8 additional analog inputs, allowing for a maximum of 24 analog inputs (16 
expansion and 8 on-board). How it is packaged will determine the number of 
expansion inputs. 

A.2. Configuration Utilities 

TASC devices can be configured using their individual configuration utility, or 
by using siteVIEW. If the configuration utility is used to configure a device, 
siteVIEW will be unaware of the change and so siteVIEW’s configuration will 
be out of date for the device. To update siteVIEW perform a complete refresh 
on the device. 

A.3. Analog Inputs 

A.3.1. Jumper Configuration 

 

Each analog input may be set to a different range via jumpers J1 to J16 in 
conjunction with the device’s configuration utility. Each analog input has two 
jumpers noting that the order of jumpers is reversed, i.e. J1 & J2 correspond 
to the highest analog input. 
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Each pair of jumpers configures one of two programmed ranges.  

 

Analog Jumper block 

8 J1 / J2 

7 J3 / J4 

6 J5 / J6 

5 J7 / J8 

4 J9 / J10 

3 J11 / J12 

2 J13 / J14 

1 J15 / J16 

Table 4 - Device Properties – Analog Jumper Configuration 

 

 

Figure 88 - Photo of Analog Jumpers 
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When a range is selected via the jumper block, the corresponding range 
must also be set in the analog configuration pages for the device. 

A 3.2.User Ranges 

 

The user may select one of four external analog ranges by supplying an 
external ‘potential divider’ resistor network. 1% tolerance resistors should be 
used. To configure an analog input for an externally supplied resistor 
network, set the jumpers the same as for 5V. 

The following table shows suggested external resistor network values for the 
user range settings. 

 

Analog 0-5.0V or 
User Range 

0-25V 

1 J16-1 to J16-2 
J15 Out 

J16-3 to J16-2 
J15-1 to J15-2 

2 J14-1 to J14-2 
J13 Out 

J14-3 to J14-2 
J13-1 to J13-2 

3 J12-1 to J12-2 
J11 Out 

J12-3 to J12-2 
J11-1 to J11-2 

4 J10-1 to J10-2 
J9 Out 

J10-3 to J10-2 
J9-1 to J9-2 

5 J8-1 to J8-2 
J7 Out 

J8-3 to J8-2 
J7-1 to J7-2 

6 J6-1 to J6-2 
J5 Out 

J6-3 to J6-2 
J5-1 to J5-2 

7 J4-1 to J4-2 
J3 Out 

J4-3 to J4-2 
J3-1 to J3-2 

8 J2-1 to J2-2 
J1 Out 

J2-3 to J2-2 
J1-1 to J1-2 

Table 5 - Device Properties – Analog Jumper Ranges 

 

Figure 89 - External Resistor Network 

2 x 5V = 10V 4 x 5V = 20V 10 x 5V = 50V 20 x 5V = 100V 

Ra = 10KΩ 
Rb = 10KΩ 

Ra = 30KΩ 
Rb =10KΩ 

Ra = 90KΩ 
Rb = 10KΩ 

Ra = 190KΩ 
Rb = 10KΩ 

Table 6 - Device Properties – Suggested External Resistor Network 
Values 
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APPENDIX B. TASC SITECOMMANDER CONFIGURATION 

The TASC siteCOMMANDER is a hardware device that can be used in 
conjunction with siteVIEW. The device has its own firmware configuration 
that can be changed either using the siteCOMMANDER Configuration Utility 
(SCCU) or by using siteVIEW.  

Some highlights of the siteCOMMANDER features include: 

 Monitoring of 8 built in contact (digital) inputs. 

 Monitoring of 8 built in analog inputs. 

 Monitoring and control of 8 built in digital outputs. 

 Support for adding and monitoring TASC Temperature Sensors. 

 Device logging. 

 Low power mode. 

 Connectivity via RS232 and FFSK. 

This section discusses how to change the siteCOMMANDER device settings. 

Refer to the siteCOMMANDER User Manual (050-015-0002) for detailed 
instructions and examples of use of the siteCOMMANDER. 

B.1. Description 

The description tab contains the name and description of the device, which is 
used in siteVIEW. 

 

Figure 90 - Device Properties 
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B.2. General 

The general tab contains read-only information about the device such as the 
device type, the device’s internal firmware version, extra device options 
available and the number of temperature sensors that are attached to the 
device. 

The “Restart Device” button forces the device to reboot the firmware. This is 
useful if the device is not recognizing a new temperature sensor, because 
the siteCOMMANDER only scans for new temperature sensors at boot time. 

 

Figure 91 - Device Properties - General 
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B.3. Startup Options 

The startup options tab contains configuration that pertain only to the startup 
of the device. The startup delay is the length of time in seconds that the 
device will wait after starting, before it begins monitoring. The enable power 
save option causes the device to switch into low power mode. When the 
device is in low power mode, it will have a sleep time. At the end of each 
sleep interval, the device will wake up and check its status. The wake on 
COS option causes the device to wake up out of low power mode when it 
detects a carrier operated squelch from the ffsk module. 

B.4. Communication 

Making changes to the communication form after the first communication has 
been established causes the communication configuration to be altered.  

The device COM port specifies the COM port the device is to use as its 
primary COM port. 

The module type of the device determines the role of the device. The 
following is a quick description of each mode: 

 Gateway: This mode is used on a single device to connect a network 
of siteCOMMANDERs to the siteVIEW Enteprise Communication 
Service.  

 Master: This mode is used in point-to-point or point-to-multipoint 
applications not involving siteVIEW products 

 

Figure 92 - Device Properties - Startup Options 
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 Slave No Mapping: This mode is used for remote devices in siteVIEW 
and non-siteVIEW applications 

 Slave Input Mapping: This mode is used strictly for point-to-point or 
point-to-multipoint applications not involving siteVIEW products 

The COM port retry count decides how many times the device should send a 
message before giving up. The retry timeout determines how long to wait for 
a response after sending a packet. 

Serial port 2 and the FFSK port can only be changed when siteVIEW is in a 
local connection with the device. This is to ensure that siteVIEW does not 
lose connectivity with the device it is configuring. To configure serial port 2 
and the FFSK port siteVIEW must connect to the device locally. 

See Recommended Communication Timing Parameters, Table 3 – 
Recommended Communication Timing Parameters, on page 38, for 
recommended timing parameters. 

 

Figure 93 - Device Properties - Communication 
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B.5. Contact Inputs 

If Enable Event is selected for a contact input, the device will notify siteVIEW 
whenever the input is turned on or off. The off state specifies if the input is 
normally in the open state or if it is normally closed. The state that is 
specified as normal then becomes the off state of the device. 

The input mode can be set as normal or toggle. If normal is selected, the 
input is edged triggered. If toggle is selected, the input is triggered based on 
levels; the input will alter its state on alternating positive levels. 

 

Figure 94 - Device Properties - FFSK Communication 

 

Figure 95 - Device Properties - Contact Inputs 
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By selecting a local output, an input can be set such that when the input is 
turned on, an output is turned on and when the input is turned off that same 
output is then turned off. 

The hold time specifies the amount of time the input must stay on before the 
output will be turned on or off. The local output specifies the output to be 
turned on and off. The output delay indicates how long the device should wait 
before turning on the local output. 

The output action can be normal, set or reset. If the output action is normal, 
then the output turns on when the input is turn on and the output turns off 
when the input is turned off. If the output action is set, then the output is 
turned on when the input is turned on, but the output is unaffected when the 
input is turned off. Reset causes the output to be turned off when the input is 
turned on, but is unaffected when the input is turned off. 

B.6. Analog Inputs 

If enable event is selected for an analog input, the device will notify siteVIEW 
whenever the input crosses either the low or high threshold voltage.  

The range indicates the analog input type that is connected to the device. If 
this value is not set correctly, siteVIEW may report invalid analog input 
information. 

Various sensors are available that attach to the analog input. If a sensor is 
connected to an analog input use the sensor drop down list to specify which 
sensor is present.  

The units will change automatically depending on the range and sensor that 
are selected. 

The analog formula and Hi & Low adjusted values allow an analog input to 
be formatted using an equation (For more information see Extra Device 
Configuration on page 49). 

The offset value allows an analog’s value to be adjusted by the specified 
amount. 

By selecting a local output, an analog input is set such that when the input 
voltage goes above the high threshold, an output is turned on and when the 
input voltage goes below the high threshold that same output is then turned 
off. An output can be assigned to both the high and low thresholds and the 
same output can be used for both or a different output can be used. 

Selecting the invert set points option causes the assigned output to turn on 
when the voltage goes below the high threshold voltage and above the low 
threshold voltage. The same output turns off when the voltage goes above 
the high threshold or below the low threshold. Only the low output is used 
when the set points are inverted. 
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The hold time specifies the amount of time the analog input must stay above 
or below the threshold before the output will be turned on or off. The local 
output specifies the output to be turned on and off. The output delay 
indicates how long the device should wait before turning on the local output. 

 

The siteCOMMANDER module cannot accept voltages on its inputs that are 
negative with respect to ground. Application of negative voltages to the digital 
and analog inputs will damage the module. 

The module provides fixed input ranges of 0-5 VDC and 0-25 VDC 
depending on jumper settings. Four user ranges of X2, X4, X10 and X20 can 
also be programmed based on a 5.12 VDC internal reference. 

B.7. Temperature Inputs 

If enable event is selected for a temperature input, the device will notify 
siteVIEW whenever the input crosses either the low or high threshold 
temperature.  

The device may have zero to eight temperature sensors present. The 
present indicator lets the user know which sensor is available for 
configuration. 

The temperature units field specifies which temperature scale to use for 
calculating values related to the temperature input. 

 

Figure 96 - Device Properties - Analog Inputs 
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By selecting a local output, a temperature input can be set such that when 
the input temperature goes above the high threshold, an output is turned on 
and when the input temperature goes below the low threshold an output is 
then turned off.  

The hold time specifies the amount of time the temperature input must stay 
above or below the threshold before the output will be turned on or off, and it 
is also the time before the event will be reported to siteVIEW. The local 
output specifies the output to be turned on and off. The output delay 
indicates how long the device should wait before turning on the local output. 

B.8. Outputs 

The off state specifies if the output is normally in the open state or if it is 
normally closed. The state that is specified as normal then becomes the off 
state of the device. 

The output mode can be set as latch or pulse. If Latch is selected, when the 
output is turned on it is left on until the output is turned off again. If pulse is 
selected, when the output is turned on the output only stays on for the length 
of times specified by the pulse width. 

 

 

Figure 97 - Device Properties - Temperature Inputs 

 



TASC siteVIEW 2.1 User Manual 050-015-0050 R07 

TASC Systems Inc. All Rights Reserved Page 112 of 175 

B.9. Device Logging – Configuration 

The log roll over determines what the device will do when its log file becomes 
full. If log roll over is enabled, the device will overwrite the oldest log entry to 
create a new one. If log roll over is not enabled, the device will stop logging 
when the data logger buffer is full. 

Selecting power up run ensures the data logger starts automatically 
whenever the device starts up. 

 

Figure 98 - Device Properties - Outputs 

 

Figure 99 - Device Properties - Device Logging 
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The data logger logs sample data at selected intervals and it logs min/max 
data for selected inputs. The buffer allocation determines how much of the 
data logger buffer is allocated to each data logger type. 

The enabled option determines if the selected input is included when logging. 
The analog and temperature inputs have a log thresholds option that will 
cause the data logger to log each time the input’s value crosses its high or 
low threshold.  

The input qualifier causes the input value to only be logged when the 
assigned input qualifier is on. So the input qualifier causes the analog or 
temperature threshold changes to be ignored if the input qualifier is off. In 
other words, when an analog or temperature input crosses a threshold, the 
value will only be logged if the assigned input qualifier is on. 

The contact inputs can be logged each time they are turned on or off, or they 
can be logged as accumulative on times. 

B.10. Device Logging – Downloading To siteVIEW 

Once device logging configuration has been setup, close the device 
properties form and open the Device Data Logger form for the selected 
device, by selecting “Edit->Data Logger” from the main menu.  

The Device Data Logger form can be used to stop and start the device 
logger, download the logs, clear the logs, view the contact input 
accumulation timers and clear the contact input accumulation timers. 

To see the status of the device logger, press the “Refresh” button in the 
“Data Logger Details” group box. If the data logger is stopped, the start time 
will be unavailable and the log counts will be empty. Once the data logger is 
started, the device will begin to store sample and min/max logs based on 
which inputs the device is configured to log. 
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Note: The threshold logs are saved and downloaded along with the Min/Max 
Log. 

The device has 9 timers that are stored on the device’s real time clock. If 
logging of these accumulator timers was enabled for the corresponding 
contact input then the device will increment the timers for every second that 
the input is in the on position. These timers are updated even when the 
device data logger is stopped. 

The last update time shows the last time that siteVIEW downloaded these 
values from the device. Press the “Refresh” button in the “Timers” group box 
to download the current accumulator timer values. 

Selecting the checkbox beside the timer and then pressing the “Clear” button 
will reset the corresponding timer back to zero.  

The maximum accumulator timer values are 16,777,215 seconds (194 days), 
after which the timer will roll over back to zero. 

The COS timer increments on receipt of the externally supplied carrier detect 
signal via the optional FFSK module. The time that carrier is present (the 
signal is active), is added to the COS accumulator. The accumulator 
accuracy is in seconds. To enable tracking of the COS accumulator, select 
open the Device Properties form, select the Device Logging tab and check 
the “Log Airtime” box. 

For more information on setting up specific logging on specific inputs, see the 
previous section Device Logging – Configuration. 

 

 

 

Figure 100 - Device Data Logger 
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Manually Downloading Device Logs 

Once the sample log or min/max log have a record count greater than zero, 
press the download button to manually download the data. The data will be 
downloaded in chunks, so depending on how much data has been stored it 
could take several packets to download all the data. Once all the data has 
been downloaded, siteVIEW will automatically clear the log. You may clear 
the logs manually by pressing the “Clear Log” button for the corresponding 
log. Stopping and starting the data logger will also clear the log data, but the 
“Clear Log” button will clear the log without stopping the data logger. 

 
Automatically Downloading Device Logs 

 

To setup automatic downloading of the sample log, create a scheduled poll 
for the device that checks the sample log count. If the sample log count is 
greater than zero, siteVIEW will automatically download and clear the sample 
log. Similarly, to setup automatic downloading of the min/max and threshold 
logs, create a scheduled poll that checks the min/max log count. If the 
min/max log count is greater than zero, siteVIEW will automatically download 
and clear the min/max and threshold logs. 
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APPENDIX C. TASC SITEPORTAL LITE CONFIGURATION 

The TASC sitePORTAL Lite is a hardware device that can be used in 
conjunction with siteVIEW. The device has its own firmware configuration 
that can be changed either using the sitePORTAL Configuration Utility 
(SPCU) or by using siteVIEW.  

Some highlights of the sitePORTAL Lite features include: 

 Monitoring of 8 built in contact inputs, plus support for adding TASC 
Contact Input expansion boards. 

 Monitoring of 8 built in analog inputs, plus support for adding TASC 
Analog Input expansion boards. 

 Monitoring and control of 8 built in digital outputs. 

 Support for adding and monitoring TASC Temperature Sensors. 

 1-2 peripheral passthrough ports. 

 Connectivity via TCP/IP, IP Modem, PSTN Modem and RS232. 

This section discusses how to change the sitePORTAL Lite device settings. 

Refer to the sitePORTAL Lite User Manual (050-015-0012) for detailed 
instructions and examples of use of the sitePORTAL Lite. 

C.1. Description 

The description tab contains the name and description of the device, which is 
used in siteVIEW. As well the device login username and password that 
siteVIEW will use to connect to the device can be changed on this page. 

 

Figure 101 - Device Details - Description 
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C.2. General 

The general tab contains read-only information about the device such as the 
device type, the device’s internal firmware version, extra device options 
available, analog and contact input expansion boards attached to the device 
and the number of temperature sensors that are attached to the device. 

C.3. Call & Modem Control 

The call & modem control tab is used to configure connection settings. 

C.3.1. Call Control 

The Peripheral Inactivity Time is the length of inactivity in minutes that the 
sitePORTAL Lite will wait before disconnecting from the peripheral device 
and returning to regular monitoring mode.  

User login Inactivity is the length of inactivity time in minutes the sitePORTAL 
Lite will wait before disconnecting from siteVIEW. 

The Login Time is the amount of time in seconds that a remote application 
has to enter in the login credentials before the sitePORTAL Lite will 
disconnect the connection. Attempts is the number of unsuccessful login tries 
the remote application has before the sitePORTAL Lite enters a state of 
hacker guard, where no one can log in for the amount of time specified in the 
field name Recycle Time. 

The Inter-Byte Timeout determines how long the com port should wait 
between incoming bytes before timing out. 
 

 

Figure 102 - Device Details - General 
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C.3.2. Device Modem Parameters 

Rings To Answer specifies the number of rings before a modem will answer 
a call.  

Modem Port Speed is the baud rate that the modem will operate at.  

Modem Option is the modem type: no modem, auto detect, internal or 
external. 

AT Command Dialect offers support for a generic modem, but also a few 
other modem types. 

AT Initialization String allows a user to enter a modem initialization string that 
the sitePORTAL Lite will use when it initializes the modem. 

Use Enhanced Telephony Features enables or disables advanced features 
such as call cadence validation. The sitePORTAL Lite will then only answer 
calls with a specified ring cadence. The cadence of the ring to answer is set 
in the Site Phone Number field of the Site Information tab.  This is only 
available if the optional plug in modem TASC PN 800-100-0046 is installed. 

The ring cadence must be entered in the following format: [x,y,z], where x is 
the length in milliseconds of the first ring, y is the length of the pause 
between rings, and z is the length of the second ring. All times are in 
milliseconds. The cadence value is surrounded by square brackets, has 
commas separating cadence values, no spaces between values, has three 
values, and all times are integer values. The sitePORTAL Lite will then only 
answer calls that have the specified ring cadence. 

If the cadence value is not entered correctly, or is blank, sitePORTAL Lite will 
ignore all incoming calls. There is one exception, if the ring cadence is a star 

 

Figure 103 - Device Details – Call & Modem Control 
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character surrounded by square brackets (ie. [*]), then all calls will be 
answered. 

Auto Search Modem Baud Rate causes the sitePORTAL Lite to attempt to 
find the baud rate of the incoming connection automatically. 

Modem Heartbeat is how often the AT initialization sequence is sent to the 
modem to make sure it I online. The Timeout is the amount of time the 
sitePORTAL Lite waits to receive a response from the modem before it 
retries the initialization and Attempts is the number of retry attempts 
sitePORTAL Lite performs. 

The Alarm Reporting Retry Interval is the time in minutes the sitePORTAL 
Lite will wait since an unsuccessful alarm report before it retries. Attempts is 
the number of unsuccessful alarm report retry attempts the sitePORTAL Lite 
will attempt before giving up. Force New Alarm sets the sitePORTAL Lite to 
report a new alarm even if previous alarm attempts have failed and are 
waiting for the retry interval to elapse. If Force New Alarm is not selected, 
new alarms will wait along with the other alarms. 

Periodic Status Report sets the sitePORTAL Lite to periodically report its 
status to siteVIEW. The Retry Interval is how often the sitePORTAL Lite will 
attempt to report its status. 

C.4. Contact Inputs 

The sitePORTAL Lite comes with 8 built in contact inputs, but can be 
expanded with a maximum of 4 TASC digital expansion boards, each with 8 
contact inputs, allowing a maximum of 40 contact inputs. 

If Enable Event is selected for a contact input, the device will notify siteVIEW 
whenever the input is turned on or off. The off state specifies if the input is 
normally in the open state or if it is normally closed. The state that is 
specified as normal then becomes the off state of the device. 
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By selecting a local output, an input can be set such that when the input is 
turned on, an output is turned on and when the input is turned off that same 
output is then turned off.  

The hold time specifies the amount of time the input must stay on before the 
output will be turned on or off. The local output specifies the output to be 
turned on and off. The output delay indicates how long the device should wait 
before turning on the local output. 

The output action can be normal, set or reset. If the output action is normal, 
then the output turns on when the input is turned on and the output turns off 
when the input is turned off. If the output action is set, then the output is 
turned on when the input is turned on, but the output is unaffected when the 
input is turned off. Reset causes the output to be turned off when the input is 
turned on, but is unaffected when the input is turned off. 

C.5. Analog Inputs 

The sitePORTAL Lite comes with 8 built in analog inputs, but can be 
expanded with a maximum of 2 TASC Analog Expansion boards, each with 8 
analog inputs, allowing a maximum of 24 analog inputs. 

If enable event is selected for an analog input, the device will notify siteVIEW 
whenever the input crosses either the low or high threshold voltage.  

The range indicates the analog input type that is connected to the device. If 
this value is not set correctly, siteVIEW may report invalid analog input 
information. 

Various sensors are available that attach to the analog input. If a sensor is 
connected to an analog input, use the sensor drop down list to specify which 
sensor is present.  

 

Figure 104 - Device Properties – Contact Inputs 
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The units will change automatically depending on the range and sensor that 
are selected. 

The analog formula and Hi & Low adjusted values allow an analog input to 
be formatted using an equation (For more information see Extra Device 
Configuration on page 49). 

The offset value allows an analog’s value to be adjusted by the specified 
amount. 

The input qualifier causes the analog threshold changes to be ignored if the 
input qualifier is off. In other words, when an analog input crosses a 
threshold, the value will only be reported to siteVIEW if the assigned input 
qualifier is on. 

By selecting a local output, an analog input can be set such that when the 
input voltage goes above the high threshold, an output is turned on and when 
the input voltage goes below the low threshold that same output is then 
turned off. 

The hold time specifies the amount of time the analog input must stay above 
or below the threshold before the output will be turned on or off. The local 
output specifies the output to be turned on and off. The output delay 
indicates how long the device should wait before turning on the local output. 
The output action offers several conditions for when the local output will turn 
on or off based on the analog voltage. 

The sitePORTAL Lite module cannot accept voltages on its inputs that are 
negative with respect to ground. Application of negative voltages to the digital 
and analog inputs will damage the module. 

 

Figure 105 - Device Properties – Analog Inputs 
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The module provides fixed input ranges of 0-5 VDC and 0-25 VDC 
depending on jumper settings. Four user ranges of X2, X4, X10 and X20 can 
also be programmed based on a 5.12 VDC internal reference. 

 

C.6. Temperature Inputs 

If Enable Event is selected for a temperature input, the device will notify 
siteVIEW whenever the input crosses either the low or high threshold 
temperature.  

The device may have zero to eight temperature sensors present. The 
present indicator lets the user know which sensor is available for 
configuration. 

The temperature units field specifies which temperature scale to use for 
calculating values related to the temperature input. 

The input qualifier causes the temperature threshold changes to be ignored if 
the input qualifier is off. In other words, when a temperature input crosses a 
threshold, the value will only be reported to siteVIEW if the assigned input 
qualifier is on. 

The hold time specifies the amount of time the temperature input must stay 
above or below the threshold before the event is reported to siteVIEW. 

 

Figure 106 - Device Properties – Temperature Inputs 
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C.7. Outputs 

The off state specifies if the output is normally in the open state or if it is 
normally closed. The state that is specified as normal then becomes the off 
state of the device. 

 

Figure 107 - Device Properties – Outputs 
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C.8. Site Information 

When an I/O event occurs, the sitePORTAL Lite will attempt to report the 
event to siteVIEW. The Network Operations Control Center information must 
be supplied in order for the sitePORTAL Lite to properly know how to 
connect to siteVIEW. Enter the IP Address and IP Port if the device is 
connected to siteVIEW via Ethernet, or supply the phone number if the 
device is connected via a PSTN modem. 

 

Figure 108 - Device Properties – Site Information 
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C.9. Peripherals 

The sitePORTAL Lite has two serial ports that can be used to connect third-
party hardware to the sitePORTAL Lite. Peripheral 2 is only available when 
the primary communication channel to the sitePORTAL Lite is either Ethernet 
or a PSTN modem, thereby freeing the second serial port. 

Third-party software can then connect to the device by having the 
sitePORTAL Lite into passthrough mode. Then siteVIEW will open a virtual 
serial port that the third-party software can communicate with. siteVIEW will 
then pass on any data it receives from the virtual port on to the sitePORTAL 
Lite, which will pass the data on to the peripheral device. Data from the 
peripheral device is passed on to the third-party application in the same way.  

Set the name of the connected peripheral device and the baud rate it expects 
to communicate at. Then select “Edit->Passthrough” from the main menu in 
siteVIEW to start peripheral passthrough. 

C.10. Peripheral Passthrough in siteVIEW 

Once a device is setup for peripheral passthrough, connect to that device. 
Once connected right click on the device’s network tree node and select 
“Passthrough” and then the peripheral that you would like to connect to. 

 

Figure 109 - Device Properties – Peripherals 
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Once the peripheral connection has begun, siteVIEW will launch a program 
that will create a virtual COM port and facilitate a connection to the peripheral 
device and any application that connects to the virtual port. Once the 
connection is established, use the peripheral device’s configuration software 
to connect to the virtual COM port. 

 

 

Figure 110 – Starting Peripheral Passthrough 

 

Figure 111 – Peripheral Passthrough Connection Waiting 
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In the figure above, siteVIEW selected COM2 as the virtual port because it 
was the first port available. Once a program then connects to COM2, the 
passthrough port window then hides itself. If the program then releases the 
COM port, the passthrough port window then becomes visible again. Closing 
the passthrough port window releases the passthrough connection and 
siteVIEW closes the connection to the device. If the passthrough connection 
sits connected for too long without passing any data to or from the device, 
then eventually the device will disconnect after the peripheral inactivity 
timeout has expired and the passthrough port window will be closed. 
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APPENDIX D. TASC SITERSM CONFIGURATION 

The TASC siteRSM is a hardware device that can be used in conjunction 
with siteVIEW. The device has its own firmware configuration that can be 
changed either using the siteCOMMANDER Configuration Utility (SCCU) or 
by using siteVIEW.  

Some highlights of the siteRSM features include: 

 Monitoring of 8 built in contact inputs, plus support for adding TASC 
Contact Input expansion boards. 

 Monitoring of 8 built in analog inputs, plus support for adding TASC 
Analog Input expansion boards. 

 Monitoring and control of 8 built in digital outputs. 

 Support for adding and monitoring TASC Temperature Sensors. 

 Connectivity via RS232 or Ethernet. 

 Low power mode. 

This section discusses how to change the siteRSM device settings. 

Refer to the siteRSM User Manual (050-015-0052) for detailed instructions 
and examples of use of the siteRSM. 
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D.1. Description 

The description tab contains the name and description of the device, which is 
used in siteVIEW.  

D.2. General 

The general tab contains read-only information about the device such as the 
device type, the device’s internal firmware version, extra device options 
available, analog and contact input expansion boards attached to the device 
and the number of temperature sensors that are attached to the device. 

 

Figure 112 - Device Details - Description 

 

Figure 113 - Device Details - General 
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D.3. Communication Settings 

Making changes to the communication form after the first communication has 
been established causes the communication configuration to be altered.  

The device COM port specifies the COM port the device is to use as its 
primary COM port. 

The module type of the device operates like a siteCOMMANDER in slave no 
mapping mode, which is used for remote devices in both siteVIEW and non-
siteVIEW applications. 

The COM port packet retry count decides how many times the device should 
send a message before giving up. The packet retry timeout determines how 
long to wait for a response after sending a packet. The inter-byte timeout 
determines how long the com port should wait between incoming bytes 
before timing out. 

Serial port 2 can only be changed when siteVIEW is in a local connection 
with the device. This is to ensure that siteVIEW does not lose connectivity 
with the device it is configuring. To configure serial port 2 siteVIEW must 
connect to the device locally. 

See Recommended Communication Timing Parameters, Table 3 – 
Recommended Communication Timing Parameters, on page 38, for 
recommended timing parameters. 

 

Figure 114 - Device Details – Communication 
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D.4. Contact Inputs 

The siteRSM comes with 8 built in contact inputs, but can be expanded with 
a maximum of 4 TASC digital expansion boards, each with 8 contact inputs, 
allowing a maximum of 40 contact inputs. 

If Enable Event is selected for a contact input, the device will notify siteVIEW 
whenever the input is turned on or off. The off state specifies if the input is 
normally in the open state or if it is normally closed. The state that is 
specified as normal then becomes the off state of the device. 

By selecting a local output, an input can be set such that when the input is 
turned on, an output is turned on and when the input is turned off that same 
output is then turned off.  

The hold time specifies the amount of time the input must stay on before the 
output will be turned on or off. The local output specifies the output to be 
turned on and off. The output delay indicates how long the device should wait 
before turning on the local output. 

The output action can be normal, set or reset. If the output action is normal, 
then the output turns on when the input is turned on and the output turns off 
when the input is turned off. If the output action is set, then the output is 
turned on when the input is turned on, but the output is unaffected when the 
input is turned off. Reset causes the output to be turned off when the input is 
turned on, but is unaffected when the input is turned off. 

D.5. Analog Inputs 

 

Figure 115 - Device Properties – Contact Inputs 
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The siteRSM comes with 8 built in analog inputs, but can be expanded with a 
maximum of 2 TASC Analog Expansion boards, each with 8 analog inputs, 
allowing a maximum of 24 analog inputs. 

If enable event is selected for an analog input, the device will notify siteVIEW 
whenever the input crosses either the low or high threshold voltage.  

The range indicates the analog input type that is connected to the device. If 
this value is not set correctly, siteVIEW may report invalid analog input 
information. 

Various sensors are available that attach to the analog input. If a sensor is 
connected to an analog input use the sensor drop down list to specify which 
sensor is present.  

 

Selecting the TASC sensor will provide configure the sensor for 
use within siteVIEW. (Since most TASC sensors provide 5V 
input, they will not be visible unless the range selected is 0-5V.) 
Once the sensor is selected, the units will change automatically 
depending on the range and sensor that are selected. 

The offset value allows an analog’s value to be adjusted by the specified 
amount. 

The analog formula and Hi & Low adjusted values allow an analog input to 
be formatted using an equation (For more information see Extra Device 
Configuration on page 49). Formulas may also be used with TASC sensors. 

The input qualifier causes the analog threshold changes to be ignored if the 
input qualifier is off. In other words, when an analog input crosses a 
threshold, the value will only be reported to siteVIEW if the assigned input 
qualifier is on. 

By selecting a local output, an analog input is set such that when the input 
voltage goes above the high threshold, an output is turned on and when the 
input voltage goes below the low threshold that same output is then turned 
off. 

The hold time specifies the amount of time the analog input must stay above 
or below the threshold before the output will be turned on or off. The local 
output specifies the output to be turned on and off. The output delay 
indicates how long the device should wait before turning on the local output. 
The output action offers several conditions for when the local output will turn 
on or off based on the analog voltage. 

The siteRSM module cannot accept voltages on its inputs that are negative 
with respect to ground. Application of negative voltages to the digital and 
analog inputs will damage the module. 

The module provides fixed input ranges of 0-5 VDC and 0-25 VDC 
depending on jumper settings. Four user ranges of X2, X4, X10 and X20 can 
also be programmed based on a 5.12 VDC internal reference. 
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Figure 116 - Device Properties – Analog Inputs 
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D.6. Temperature Inputs 

If Enable Event is selected for a temperature input, the device will notify 
siteVIEW whenever the input crosses either the low or high threshold 
temperature.  

The device may have zero to eight temperature sensors present. The 
present indicator lets the user know which sensor is available for 
configuration. 

The temperature units field specifies which temperature scale to use for 
calculating values related to the temperature input. 

The input qualifier causes the temperature threshold changes to be ignored if 
the input qualifier is off. In other words, when a temperature input crosses a 
threshold, the value will only be reported to siteVIEW if the assigned input 
qualifier is on. 

The hold time specifies the amount of time the temperature input must stay 
above or below the threshold before the event is reported to siteVIEW. 

By selecting a local output, a temperature input is set such that when the 
input temperature goes above the high threshold, an output is turned on and 
when the input temperature goes below the low threshold, an output is then 
turned off. 

 

Figure 117 - Device Properties – Temperature Inputs 
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D.7. Outputs 

The off state specifies if the output is normally in the open state or if it is 
normally closed. The state that is specified as normal then becomes the off 
state of the device. 

 

 

Figure 118 - Device Properties – Outputs 
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APPENDIX E. PING DEVICE CONFIGURATION 

Ping devices are a new device type, introduced in siteVIEW v2.1. Ping 
devices work in a similar manner as the widely used Ping networking utility 
which is used to test the reachability of a host on an Internet Protocol (IP) 
network.  

siteVIEW Ping devices can be used to determine whether an IP device is 
available or “up and running”. 

E.1. Adding Ping Devices 

Before adding Ping device, an Ethernet communication port must be added. 
Ping devices cannot be added to Serial communication ports. 

To add a Ping device, use the Edit – Add Device function or right-click on the 
Ethernet communication port and select Add Device. The resulting Device 
Monitoring Wizard is used to define the Ping device’s properties: 

For the Device Details section, select Ping as the Device Type, then select 
Next 

For the Device Identification section, enter a user-friendly name describing 
the Ping device in the Name field. Optionally, add additional long-form 
information within the Description field, then select Next. 

For the Connection Details, enter an IP (IPv4) address or a DNS name for 
the device. siteVIEW will automatically resolve a DNS name to the IPv4 
address of the device. Then press Finish to add the Ping device. Currently, 
siteVIEW does not support IPv6 addressing. 

 

 

http://en.wikipedia.org/wiki/Ping_(networking_utility)
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Figure 119 - Ping Device - Add Device 

E.2. Using Ping Devices 

Ping devices can only be polled using a siteVIEW DeviceStatus command. 
The DeviceStatus command is interpreted by the siteVIEW Communication 
Service as request to send ping message. 

siteVIEW Ping devices are “stateless” devices and therefore are never 
“offline”. Ping devices either respond to a Device Status command, which 
indicates that the device is available, or they do not respond, which indicates 
that the device is unavailable. Unavailability can be alarmed using 
siteVIEW’s “Non-Responsive” alarm trigger. 

 

E.2.1. Understanding Ping Transactions 

Each DeviceStatus poll initiates a ping message transaction. The ping 
transaction sends a single ICMP packet to the Ping device (host) and listens 
for a response.  

If a response is received, the Communication Service will signal that the 
DeviceStatus command has completed successfully. The Ping device will 
also show that it is ready for another transaction. 

If the device does not respond after 500ms, the Communication Service will 
try again three times (every ~3 seconds). If after the initial attempt and the 
three retries, the device still hasn’t responded, the Communication Service 
will signal that the device has timed out and is not responding. This “No 
Response” event can be used with the siteVIEW alarm system to indicate 
that the device is not available on the network. On the Sites network tree, the 
Ping device will also show an “X”, indicating a failed transaction, but will be 
ready for another transaction. 

 

E.2.2. Generating Ping Transactions 

The DeviceStatus command can be sent in two ways: 
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 By pressing the Refresh button which sends out an immediate 
DeviceStatus command. This method is useful to quickly verify the 
device’s availability as required. 

o If the Ethernet communication port is selected in the Sites 
network tree when the Refresh button is pressed, all Ping 
devices underneath the Ethernet communication port will be 
sent a DeviceStatus command. 

o If a specific Ping device is selected in the Sites network tree 
when the Refresh button is pressed, only the selected Ping 
device will be sent a DeviceStatus command. 

 The most typical use for Ping devices is to set up a DeviceStatus poll 
using siteVIEW’s Polling Configuration utility. In this way, 
DeviceStatus commands can be sent to a Ping device(s) periodically 
and if the device doesn’t respond, a siteVIEW alarm can be triggered. 
 
Though the Polling Configuration utility allows for non-DeviceStatus 
commands to be sent to Ping devices, non-DeviceStatus commands 
are ignored by the siteVIEW Communication Service. 

 

E.2.3. Monitoring Ping Devices Transactions 

The combination of a repetitive Device Status poll and a Non-Responsive 
alarm will provide functional monitoring of the device – allowing notifications 
if the device becomes unavailable. 

Within the Alarm Configuration utility, select the Ping device, but for I/O 
select “None” – this creates a Non-Responsive alarm for the device. 

 

Figure 120 - Ping Device - Non-Responsive Alarms 

E.2.4. Reviewing Ping Device Transactions 

siteVIEW logs all activity with Ping devices.  

 siteVIEW History – To view historical communication and alarm 
information associated with a Ping device, select the History button to 
initiate a Log View session. The Communication link shows all 
communication transactions, filterable by device type and other 
criteria. The Alarm link shows all alarm occurrences, filterable by 
device type and other criteria. 
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 Device Communication Log – each device keeps a detailed log of 
transaction communication. This detailed text file is found in the 
CommSvc folder and is called TransmitReceive<device name>.log. 
The <device name> is the IP or DNS name of the device – for 
example: TransmitReceive192.168.0.100.log. To differentiate 
between TASC IP devices, remember that Ping devices do not 
reference a port number. 
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APPENDIX F. SITEVIEW TO DEVICE COMMUNICATIONS 

F.1. siteVIEW to siteRSM Communication Management 

F.1.1. Overview 

There are three methods of communicating with a siteRSM device: 

 Serial Device – using a computer COM port 

 Lantronix CPR Port – using a Lantronix’s COM Port Redirector (CPR) 
technology 

 Ethernet Port – using IP-based communication 

During normal operations TASC serial, CPR-based serial and Ethernet 
devices, work identically. Each device processes transactions in order 
received. If multiple commands are sent – for example, as the result of a 
Refresh operation – these commands are queued and transacted 
sequentially. 

F.1.2. Selecting TASC Serial, CPR Serial and Ethernet Devices 

Since there are several ways to connect siteVIEW to a siteRSM, here are 
some guidelines to build a robust monitoring network: 

 Use the siteRSM’s “primary” transmission port as the main connection 

o Only one port on the siteRSM can be configured to send 
threshold events - by default, the IP port on the siteRSM is 
defined as the primary port. Use the primary port as the main 
connection because it can respond to refresh and poll 
requests, and send threshold events in real-time. 

o While the siteRSM’s serial port may be configured as the 
primary transmission port, generally, it is purposed for local 
configuration via the SCCU software. In the case where the 
serial port is configured as the primary port, use a siteVIEW 
serial device to monitor the siteRSM. 
 

 Use only one siteVIEW device per siteRSM connection 

o It is not possible to connect to a siteRSM IP port using multiple 
active siteVIEW devices simultaneously since the siteRSM’s 
IP port accepts only one connection at a time. Use either an IP 
device or a CPR serial device connection – not both. 
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For existing siteVIEW networks, it is possible to migrate 
from CPR devices to IP devices. In this case, it is 
important to remove, or at minimum, disable, the CPR 
device when adding the IP device for the siteRSM. 

 

 A Ping device can be added to a siteRSM connection to monitor 
availability 
 

o A Ping device may be added to a siteRSM, even if an IP 
device or CPR device previously exists. A Ping device works 
independently to a IP device or CPR device to monitor the 
availability of the siteRSM. 
 

 A Ping devices can be added to non-siteRSM connections 
 

o A Ping device may be added to monitor non-siteRSM devices 
within a network. For example, it may be useful to monitor the 
availability of a critical device(s) within the network. 

 



TASC siteVIEW 2.1 User Manual 050-015-0050 R07 

TASC Systems Inc. All Rights Reserved Page 142 of 175 

 

F.1.3. Differences between TASC Serial, CPR Serial and IP Devices 

However, during failed communications and communication interruption 
recovery, there are subtle differences related to the differences between the 
underlying physical communication methods: 

 

 Serial Port CPR Port Ethernet Port 

Connection interrupted 
failures – for example, if a 
cable is unplugged 

If the cable is 
disconnected, current and 
all queued transactions will 
be attempted, but will fail 
(with retries) as timed out 
(no response). 

Initial transactions will fail 
due to time out (with 
retries).  

 

When the connection is 
confirmed as failed (as 
determined by the CPR 
Manager’s TCP Keep Alive 
settings), the transaction 
being processed will fail 
with a communication 
error.  

 

All subsequent queued 
transactions remain 
queued.  

Initial transactions will fail 
due to time out (with 
retries).  

 

In 30 seconds, when the 
connection is confirmed 
as failed, the transaction 
being processed will fail 
with a communication 
error.  

 

All subsequent queued 
transactions remain 
queued.  

Recovery from 
connection interruptions 

If the cable is reconnected, 
all subsequent commands 
will be transacted normally. 

siteVIEW continuously 
checks the connection and 
upon recovery, all queued 
events are processed. 

siteVIEW continuously 
checks the connection 
and upon recovery, all 
queued events are 
processed. 

 

It is important to note that during connection interruptions, all events from the 
TASC device may be lost, therefore the connection should be validated 
frequently. 

 

 

To ensure that serial, CPR serial and IP devices are connected, use a repetitive 
Device Status poll (every x minutes) in combination with a Non-Responsive 
alarm. Using this mechanism will allow notification of any connection failures 
and limit any loss of events being sent from the device. 
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F.1.4. Communication Alarms 

Steps can be used to ensure administrative awareness of communication 
problems. siteVIEW can be configured to report non-responsive connections 
using the built-in notification system. (The non-responsive alarm functionality 
is also available via the SNMP notification option.) 

 

Use the non-responsive alarms to receive notifications of failed 
connections to quickly localize and make any required repairs to 
the communication infrastructure used by siteVIEW to 
communicate with siteRSM devices.  

To add a non-responsive communication alarm: 

 Bring up the Alarm Configuration dialog 

 Select the Server, COM Site and Device to monitor. 

Importantly, leave the I/O option as “- None –“. The “- None –“ 

option is used to signal the Device communication health 

 Optionally, set any Notifications to be used for the alarm 

(Sound, Text to Speech, Email or SNMP) 

 Press the “Update” button to save and activate the alarm. 

 

 

 

Figure 121 – Communication Alarms – Non-Responsive Alarms 
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F.1.5. Communication Logging System 

siteVIEW provides a communication logging sub-system: 

 TransmitReceiveCOMxxx log files - The TransmitReceiveCOMxxx 
(where xxx is the port number) log file system, which is enabled by 
default, provides detailed information related to the health and status 
of the COM port. 
 

This file is located in the C:\Program Files (x86)\TASC\siteVIEW 

Enterprise Edition 2.0\CommSvc directory 

 

 

 CommunicationService log file – siteVIEW a new, though optional, log 
file called the CommunicationService.log. This log file provides high-
level operational information for the siteVIEW Communication Service 
software module, including: 

o Message requests and responses from siteVIEW (Data 
Handler) 

o Overall health of all underlying communication ports 

By default, the CommunicationService.log file is disabled. To enable 
the CommunicationService.log file: 

o Navigate to the C:\Program Files (x86)\TASC\siteVIEW 

Enterprise Edition 2.0\CommSvc directory 

o Use a text editor to edit the 

CommunicationService.exe.config configuration file 

o Add the following line before the </appSettings> line: 

<add key="CommunicationServiceLogging" value="True" /> 

o Save the file 

o Use the TASC Communication Service Utility to restart the 
CommunicationService  

 

Figure 122 – Communication Logging System – Transmit Receive 
Log Files 
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o This file is located in the C:\Program Files 
(x86)\TASC\siteVIEW Enterprise Edition 2.0\CommSvc 
directory 

 

 

 

Figure 123 – Communication Logging System – Communication 
Service Log File 
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F.1.6. Communication State Icons 

 

State Image Description of State 

 

Communication Service online 

 

Communication Service offline 
Check to see if communication service is running or connected to 
siteVIEW Data Handler 

 

Communication (Serial) Port enabled and available 

 

Communication (Serial) Port disabled or unavailable 
If port is disabled, it must be enabled to communicate. 
Check to see if cable unplugged or, in the case of a CPR port, 
whether the IP Address is available 

 

Device enabled and available 

 

Device disabled or unavailable 
If device is disabled, it must be enabled to communicate.  
If previous communication to device was lost (e.g., no response), or 
other communication error - check to see if device is operational or 
if there is a connection (e.g., cabling) issue 

 

Modem connected 

 

Modem disconnected or unavailable 
Check modem status. 

 

Modem pool available 

 

Modem pool unavailable 
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State Image Description of State 

 

Alarm is active 

 

siteVIEW Network 
Top most node on siteVIEW network. All communication services 
nodes and children will be connected here. 

 

Group Folder 
Group folder allows organization of devices 

 siteVIEW system 
Top most node within a siteVIEW system – includes groupings and 
network. 

 

Shortcut to an enabled and available Device 
A shortcut to a device within a group folder 

 

Shortcut to a disabled or unavailable Device  
If device is disabled, it must be enabled to communicate.  
If previous communication to device was lost (e.g., no response), or 
other communication error - check to see if device is operational or 
if there is a connection (e.g., cabling) issue 

 

Ethernet Port enabled and available 

 

Ethernet Port disabled or unavailable 
If port is disabled, it must be enabled to communicate. 
Check to see if cable unplugged or, in the case of a CPR port, 
whether the IP Address is available 

 

Device Updates Waiting 
siteVIEW has sensed a difference between the siteVIEW 
representation of the device and the actual device contents. 
siteVIEW recommends a status and/or configuration refresh to 
ensure that the siteVIEW device representation is synchronized 
with the actual device. 
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F.2. siteVIEW Communication via Lantronix CPR Ports 

F.2.1. Lantronix CPR Overview 

siteVIEW utilizes Lantronix technology to implement an IP connection to the 
siteRSM. siteVIEW and related components can be configured to ensure 
robust communications. 

siteVIEW can automatically recognize failed IP connections on Lantronix 
Com Port Redirector (CPR) managed ports for siteRSM devices. Specifically, 
failures are recognized at any attempt to request information (write) from a 
damaged IP connection. Failed connections are immediately closed and 
marked as unavailable. 

This siteVIEW manages all of these IP communication failure modes: 

 (Temporary) Ethernet disconnections – this represents the most 
prevalent failure type and includes unplugged networking cables, 
router/switch malfunctions and ISP network adjustments. 

 siteRSM power cycles – restarting the siteRSM will disrupt 
communications. This failure is prevalent during deployment. 

 Loss of Windows network adapter – includes any disruptions to the 
siteVIEW host’s underlying IP infrastructure. For example, entry/exit 
from sleep mode or changes to the Window’s network system setup. 

 

Figure 124 – siteVIEW to siteRSM Connections 



TASC siteVIEW 2.1 User Manual 050-015-0050 R07 

TASC Systems Inc. All Rights Reserved Page 149 of 175 

Auto-recovery is implemented by using siteVIEW’s polling mechanism to 
constantly recheck the port for a restored connection. 

 

TASC Systems recommends using an indefinite Device Status poll 
on each CPR serial-to-IP port. This poll acts as a “ping” mechanism 
and serves two purposes: 

 Allows siteVIEW to recognize (and close) failed connections 

 For failed ports, the Device Status poll is a recurring check for 

a restored connection 

The Device Status poll should be set to request Device Status 
information every minute, indefinitely.  

A Device Status poll is recommended as it represents the smallest 
message exchange between siteVIEW and the siteRSM over 
connection and, hence, has no material influence on the system’s 
communication overhead. Furthermore, no I/O information is 
exchanged thereby ensuring that all alarming and site mapping is 
influenced. 

Using a check every minute, the smallest time granularity for a 

siteVIEW poll, ensures that a failed connection is recognized in no 

more than a minute. Furthermore, a connection is re-established in no 

more than a minute after it has been restored. 

 

 

Figure 125 – Connection Management – Device Status Poll 
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F.2.2. siteRSM Tunnel Settings 

The siteRSM’s IP Interface is implemented using an embedded Lantronix 
XPort Pro (or XPort) adapter. Though the Lantronix Xport Pro (or XPort) is 
pre-configured at the factory, reducing the TCP Keep Alive time to 
10,000msec is recommended to more quickly dismantle bad connections. 

 

TASC Systems recommends setting the Lantronix XPort Pro’s 
Tunnel setting for the TCP Keep Alive parameter to 10,000 msec. 
This ensures that any broken or failed connection is dismantled in no 
more than ~10 seconds of failure. 

To change the setting: 

 Use a web browser to access the IP address of the siteRSM 

 Login to the siteRSM using user=admin and password=PASS 

 Select the Tunnel option (on the left-hand menu list) 

 Select Accept Mode option (on the top menu list) 

 Change the TCP Keep Alive value to 10000 msec 

 Press the “Submit” button to accept and save the change 

 

 

 

 

 

Figure 126 – siteRSM Tunnel Settings – XPort Pro 



TASC siteVIEW 2.1 User Manual 050-015-0050 R07 

TASC Systems Inc. All Rights Reserved Page 151 of 175 

 

TASC Systems recommends setting the Lantronix XPort’s Tunnel 
setting for the TCP Keep Alive parameter to 10,000 msec. This 
ensures that any broken or failed connection is dismantled in no more 
than ~10 seconds of failure. 

To change the setting: 

 Use a web browser to access the IP address of the siteRSM 

 Login to the siteRSM using user=admin and 

password=<empty> 

 Select the Server option (on the left-hand menu list) 

 Change the TCP Keep Alive value to 10 seconds 

 Press the “OK” button to accept and save the change 

 

 

 

Figure 127 – siteRSM Tunnel Settings - XPort 
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F.2.3. Lantronix CPR Settings 

The siteVIEW IP infrastructure is implemented using the Lantronix CPR 
Manager software, which provides IP connections for serial ports used within 
siteVIEW. Amended settings are recommended to more quickly dismantle 
bad connections. 

 

TASC Systems recommends setting the CPR Manager port setting 
for the TCP Keep Alive parameter to 10,000 msec. This ensures that 
any broken or failed connection is dismantled in no more than ~10 
seconds of failure. 

TASC Systems recommends disabling the CPR Manager port 
setting for Timeout Reconnect. This ensures that failed port is closed 
until fully restored by siteVIEW. 

To change the setting: 

 Run the Lantronix CPR Manager software 

 Select the COM port to modify 

 On the Settings tab, ensure TCP Keep Alive is enabled 

(checked), set the KeepAlive Time to 10000 msec and 

KeepAlive Interval to 1000 msec 

 On the Settings tab, disable (uncheck) the Timeout 

Reconnection option. 

 Press the “Save” button on the top ribbon menu to accept and 

save the changes 

 

 

 

 

Figure 128 – siteRSM Tunnel Settings 
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F.3. siteVIEW Communication via Ethernet Ports 

F.3.1. Adding Ethernet Devices 

To connect to a TASC device via IP, an Ethernet communication port must 
be added.  

Once an Ethernet port has been added, use the Edit – Add Device function 
or right-click on the Ethernet communication port and select Add Device. The 
resulting Device Monitoring Wizard is used to define the TASC IP device’s 
properties: 

 For the Device Details section, select the type of TASC device and 
address then select Next 

 For the Device Identification section, enter a user-friendly name 
describing the TASC device in the Name field. Optionally, add 
additional long-form information within the Description field, then 
select Next. 

 For the Connection Details, enter an IP (IPv4) address or a DNS 
name for the device. siteVIEW will automatically resolve a DNS name 
to the IPv4 address of the device. Specify the port number, typically 
for siteRSM devices this will be 10001. Specify the Packet Timeout 
(time between retries), then press Finish to add the device.  
 
IPv6 interfaces are not supported. 
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Figure 129 - Ethernet Port Communication - Add Device 

 

F.3.2. Using Ethernet Devices 

TASC IP devices operate almost the same as conventional serial or CPR 
devices, with the only difference being the underlying physical 
communication interface.  

F.3.2.1. Understanding Ethernet Device Transactions 

For TASC devices, siteVIEW supports a set of TASC protocol commands. 
These commands allow siteVIEW to request either status or configuration 
information from the device. The siteVIEW Communication Service sends 
each command as a transaction to the device. 

If a response to a transaction is received, siteVIEW will interpret and process 
the results automatically. 

If the device does not respond within the Interbyte timeout specified, the 
Communication Service will try again as per the number of Retries 
configured for the device. If after the initial attempt and the three retries, the 
device still hasn’t responded, the Communication Service will signal that the 
device has timed out and is not responding. This “No Response” event can 
be used with the siteVIEW alarm system to indicate that the device is not 
available on the network. On the Sites network tree, the device will also show 
an “X”, indicating a failed transaction. 

F.3.2.2. Generating IP Device Transactions 

siteVIEW communicates with IP devices, as with serial or CPR device, in the 
following three ways: 

 Through manual refresh button presses. Each refresh button press 
consists of multiple commands, which are processed sequentially as 
individual transactions. There are three types of refreshes: 

o Status refresh: commands to request the current status of the 
device and associated I/O. 
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o Configuration refresh: commands to request the current 
configuration of the device. 

o Full: commands to request both status and configuration of the 
device. 

 Through scheduled polled commands. Use the siteVIEW Polling 
Configuration editor to set up one or more commands to send to the 
device. 

 Through events received from the device based on digital input 
change of state, analog input threshold crossings or temperature 
threshold crossings. 

F.3.2.3. Monitoring TASC Ethernet Device Transactions 

The combination of a repetitive Device Status poll and a Non-Responsive 
alarm will provide functional monitoring of the device – allowing notifications 
if the device becomes unavailable. 

Within the Alarm Configuration utility, select the IP device, but for I/O select 
“None” – this creates a Non-Responsive alarm for the device. 

 

Figure 130 - Ethernet Port Communication - Monitoring Port Health 

F.3.2.4. Reviewing Ethernet Device Transactions 

siteVIEW logs all activity with IP devices.  

siteVIEW History – To view historical communication and alarm information 
associated with a IP device, select the History button to initiate a Log View 
session. The Communication link shows all communication transactions, 
filterable by device type and other criteria.The Alarm link shows all alarm 
occurrences, filterable by device type and other criteria. 

Device Communication Log – each device keeps a detailed log of transaction 
communication. This detailed text file is found in the CommSvc folder and is 
called TransmitReceive<device name>.log. The <device name> is the IP or 
DNS name of the device, followed by an underscore and then followed by the 
port number – for example: TransmitReceive192.168.0.200_10001.log. To 
differentiate between TASC Ping devices, remember that Ping devices do 
not reference a port number. 
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F.4. Migrating TASC Serial or CPR Serial Devices to Ethernet 
Devices 

To take advantage of a direct IP connection, it may be desirable to convert 
existing TASC serial or CRP serial devices to an IP device. While the 
process of adding an IP device will automatically upload fundamental 
information directly from the siteRSM, including basic I/O configuration, 
siteVIEW-specific information, which is stored in the siteVIEW database, 
must be also considered to fully convert the device to IP. siteVIEW-specific 
database information includes panel designs, formulas, alarms, poll 
schedules and mapping. 

F.4.1. Adjusting siteRSM IP Settings 

Check to see if the siteRSM requires Adjusting 

Older siteRSMs must be prepared for siteVIEW IP connections. To identify if 
the siteRSM’s configuration must be prepared for siteVIEW IP connections, 
using an Internet browser, navigate to the IP address of the siteRSM 
(user=admin, password=<nothing/empty>).  

If you are unable to login (Error=401 Authorization Failed), then no 
configuration changes are required, the siteRSM is ready for use with 
siteVIEW. 

However, if you see a screen like the one below, indicating the siteRSM’s IP 
interface is using an XPort Device Server, then additional steps must be 
taken to prepare the siteRSM for operation with siteVIEW’s IP interface. 

 

Figure 131 - Migrating to Ethernet - siteRSM Config Logon Screen 
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Adjust Serial Packing Settings 

For siteRSMs that require adjustments, use a Telnet session to adjust the 
Serial Packing Control, so that siteVIEW messages will be sent as one 
packet, not multiple. To do this: 

1. Run the Lantronix Device Installer software and then allow the Device 
Installer software to locate the siteRSM’s adapter (IP address) 

2. Select the siteRSM adapter and then select the Telenet Configuration tab and 

press Connect 

 

Figure 132 - Migrating to Ethernet - Telnet Config 

 
3. Press Enter to enter the configuration menu, then select the “1 – Channel 1” 

option. 

http://www.lantronix.com/device-networking/utilities-tools/device-installer.html
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Figure 133 - Migrating to Ethernet - Select Channel 

 
4. Press Enter (no change) until you get to FlushMode.  The default is 77, which 

means that Packing is disabled.  Enter f7 and Enter, to enable Packing.  The 

default for Pack Cntrl is 00, which means 12ms Packing Interval.  Enter 01 and 

Enter, which means 52ms Packing Interval.  Press Enter (no change) for the rest 

of the settings, until you return to the menu. 
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Figure 134 - Migrating to Ethernet - Flush Mode 
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5. Press 9 and Enter to Save and exit. 

 

Figure 135 - Migrating to Ethernet - Save Config 

 

 

While the Device Installer offers a web interface option to adjust these settings, 
TASC recommends using the Telnet interface, as cached settings may result in 
unexpected behavior using the web interface. 
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F.4.2. Creating the IP Device 

The following steps are recommended to convert an existing TASC Serial or 
CPR Serial device to an IP device: 

1. Ensure that the CPR Serial device is disabled. Since the IP connection 
on a siteRSM allows one connection at a time, disabling the CPR Serial 
will ensure that the IP device is given precedence to the connection. 

2. Create an Ethernet communication port. This port represents the 
Ethernet adapter for siteVIEW’s communication service and will serve as 
the connection to all IP devices. 

  

Figure 136 - Migrating to Ethernet - Create Ethernet Port 

3. Create a siteRSM device under the Ethernet communication port. Use 
the IP address for the siteRSM – if you previously had a CPR serial port, 
use the IP address which was used within the CPR Manager software for 
the CPR serial port. The port address by default is 10001. Packet 
Timeout is the amount of time to wait before retrying a communication 
message – the default is 2000msec (2 seconds). 

  

Figure 137 - Migrating to Ethernet - Add Device 

As part of the creation process, siteVIEW will automatically interogate the 
siteRSM and upload all information related to the device’s hardware 
configuration and current status – this includes: 

 Amount of digital inputs, digital outputs, analog inputs and 
temperature inputs, and which points are enabled/disabled. 
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 Current I/O configuration including: 

o Digital inputs – off state, hold times, local outputs and output 
action 

o Analog inputs – ranges, sensor types, offsets, qualifiers, 
thresholds, local outputs and hold times 

o Temperature inputs – units, qualifiers, thresholds, local 
outputs and hold times 

o Outputs – off states 

F.4.3. Migrating siteVIEW-specific Data 

Panel Information 

1. Export the panel design from the existing CPR serial (or TASC serial) 
device. The panel design includes the background image and I/O control 
user interface settings. To export, right-click anywhere on the Panel View 
screen for the CPR serial (or TASC serial) device and select “Export 
Panel”, then select a location to store the resulting .PNL file. 

 

Figure 138 - Migrating to Ethernet - Export Panel 

2. Import the panel design to the new IP device. To import, right-click 
anywhere on the Panel View screen for the IP device and select “Import 
Panel”, then select the previously saved .PNL file. During the import 
process, an Importing Options dialog will be presented. To ensure that 
the panel mimics the information previously assigned, enable both the 
“Import names of panel control items” (which ensures any names 
previously attached to your panel are imported) and “Delete extra panel 
controls that are not in the import file” (which will delete any controls that 
were not in the previous panel). 
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Figure 139 - Migrating to Ethernet - Import Panel 

 

Update Formulas 

3. If the previous TASC serial or CPR serial device used formulas, adjust 
the properties of the analog inputs to use the formula. Open up the 
Device Properties and select the Analog Inputs tab, and then use the 
Formula drop down list to select the appropriate formula. 

 

Figure 140 - Migrating to Ethernet - Update Formulas 

 

Create Alarms 

4. Create the alarms for the IP device using the Alarm Configuration form. 
At this time, alarms cannot be modified or exported/imported for a new 
device - it is necessary to re-create the alarms. 

Adjust Scheduled Polls 

5. Adjust the scheduled polls for the IP device using the Schedule Polling 
Configuration form. Select the polls that you would like to add the IP 
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device to and then use the “Add” button to include the IP device to the list 
of devices support for the selected poll. 

 

Figure 141 - Migrating to Ethernet - Adjust Scheduled Polls 

 

Create Site Mappings 

6. Create the site mappings for the IP device using the Site Mappings 
Configuration form. At this time, site mappings cannot be modified or 
exported/imported for a new device - it is necessary to re-create the site 
mappings 

F.4.4. Testing and Finalizing Migration 

1. Confirm operation of the IP device. Use the IP device during normal 
operations to verify that the device is operating properly before deleting 
the previous CPR serial or TASC serial devices. 

2. Delete the CPR serial or TASC serial devices. Once the migrated IP 
device has been validated, delete the obsolete CPR serial or TASC serial 
device. This is an optional step and can be carried out at any time as long 
as the device remains disabled. 
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APPENDIX G. SITEVIEW PANEL DESIGN 

G.1. Panel Design Guidelines 

siteVIEW panel is the container for the siteVIEW view window. The panel 
image is the background image used to define the context for the user. 

G.1.1. Panel Image Size 

Maximum panel background sizes for a siteVIEW user interface are 
determined by resolutions provided by your system’s graphics card. (It is 
useful to remember that the resolution is determined by the graphics card 
and then matched to the monitor.)  

You must account for ~150 pixels used vertically (menus, status) and ~410 
pixels (typical) used vertically (network tree, communication and alarm 
windows). That is, use the given screen resolution, subtract the pixels used 
by the siteVIEW software to arrive at the allowable panel background size. 

Below are popular screen resolutions for Windows platforms (shown in rough 
order of popularity as of end of year 2012) and the associated siteVIEW 
background panel size: 

 

 

Screen 
Resolution 

Recommended 
siteVIEW Background 

Panel Image Size 

 
 

Comments 

1920 x 1080, 

1920 x 1200 

1400-1500 x 930 16:9, recent desktops, *Recommended, popular*, 

1920 x 1200 (used by 24” widescreen LCD monitors) 

1366 x 768 950 x 615 16:9, laptops *Popular* but limited vertical depth, 

(Minimum resolution required to support all the features of Windows 8) 

1280 x 720 870 x 570 16:9, recent laptops/desktops *Popular* but limited vertical depth 

1680 x 1050, 

1600 x 900 

1190 x 750 16:9, recent desktops/laptops 

1680 x 1050 (used by 20”/22” widescreen LCD mointors) 

1280 x 1024 870 x 870 4:3, older resolution, declining in popularity 

 
Sources:  

 http://www.w3schools.com/browsers/browsers_resolution_higher.asp (mentioned popular and/or growing in 
popularity resolutions). 

 http://msdn.microsoft.com/en-us/library/windows/apps/hh780612.aspx (for Windows 8 resolutions) 

 http://windows.microsoft.com/en-CA/windows7/Getting-the-best-display-on-your-monitor 

http://www.w3schools.com/browsers/browsers_resolution_higher.asp
http://msdn.microsoft.com/en-us/library/windows/apps/hh780612.aspx
http://windows.microsoft.com/en-CA/windows7/Getting-the-best-display-on-your-monitor
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 It may be beneficial to create a wider canvas than the panel’s background 
image to allow storage of hidden controls. In this way, when the screen is 
unlocked the unused controls are accessible via a simple scroll. 

Due to their popularity, it may be desirable to design the panel a widescreen 
(16:9) format. Wider formats are recommended because users can control 
the hiding or modifying the pixels allocated to the network tree and/or the 
Communication/Alarm regions. 

G.1.2. Panel Image Layout 

The following guidelines are recommended for creation of siteVIEW panels: 

 A grouping element (e.g., lined perimeter, box) should be used to 
enclose all siteVIEW controls. Sub-grouping elements should be used 
to group controls of similar functionality – for example, all 
environmental controls may be placed together. 

 All critical (i.e., alarming) controls should be placed near the top 
and/or grouped together 

 All controls should be accompanied by either an icon or label to 
clearly indicate functionality. 

 A title, associated logo or both should be placed at the top of the 
screen to indicate the domain of the panel. For example, if the panel 
is for a particular site, the site’s name could be the title or if the panel 
is designed for a particular customer, the customer’s logo could be 
displayed at the top. Breadcrumb navigation may be used as part of 
the titling. 

 The recommended format for panel backgrounds is either PNG or 
JPG. 

 If siteVIEW will be deployed on a touchscreen, layout sizing must 
take into account human ergonomics to ensure proper selection of 
siteVIEW controls. 

G.1.3. Panel Sub-Groups 

Typical panel sub-group elements include: 

 Transmit/Receive information (e.g., forward power, transmit 
voltage/current) 

 Equipment related information (e.g., signals from the radio/repeater) 

 Environmental information (e.g., door sensor, temperature, fuel, 
battery levels) 

http://en.wikipedia.org/wiki/Breadcrumb_(navigation)
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G.1.4. HMI Standards 

The following HMI standards may be considered as part of the panel design 
process. They provide guidance on color schemes, layout and other 
ergonomic factors. 

 ISA (Instrument Society of America) 101 Human-Machine Interface:  

o Official Standard: 
http://www.isa.org/MSTemplate.cfm?MicrositeID=1142&Com
mitteeID=6899  

o 3rd Party Overview: http://www.yca-yokogawa-
usersgroup.com/uploads/3/1/8/5/3185440/mesatutorial_-
_isa101_hmiworkshop.pdf 

 A Human Factors Approach to Supervisory Control Interface 
Improvement: http://cdn.intechopen.com/pdfs/4695/InTech-
A_human_factors_approach_to_supervisory_control_interface_impro
vement.pdf 

 

Figure 142 – Sample Panel Layout 

http://www.isa.org/MSTemplate.cfm?MicrositeID=1142&CommitteeID=6899%20
http://www.isa.org/MSTemplate.cfm?MicrositeID=1142&CommitteeID=6899%20
http://www.yca-yokogawa-usersgroup.com/uploads/3/1/8/5/3185440/mesatutorial_-_isa101_hmiworkshop.pdf
http://www.yca-yokogawa-usersgroup.com/uploads/3/1/8/5/3185440/mesatutorial_-_isa101_hmiworkshop.pdf
http://www.yca-yokogawa-usersgroup.com/uploads/3/1/8/5/3185440/mesatutorial_-_isa101_hmiworkshop.pdf
http://cdn.intechopen.com/pdfs/4695/InTech-A_human_factors_approach_to_supervisory_control_interface_improvement.pdf
http://cdn.intechopen.com/pdfs/4695/InTech-A_human_factors_approach_to_supervisory_control_interface_improvement.pdf
http://cdn.intechopen.com/pdfs/4695/InTech-A_human_factors_approach_to_supervisory_control_interface_improvement.pdf
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G.1.5. Panel Image Design Tools 

While there are many tools that can be used to design background panel 
images, the following considerations may be useful in the selection of a 
design tool: 

 Ability to concretely define in pixels canvas size, grouping elements 
and sub-grouping elements 

 Ability to control location of titling, logos and/or icons by pixel 

 Ability to generate PNG or JPG files 

Suitable products, shown in order of recommendation are listed: 

 Adobe Photoshop (or Illustrator) or equivalent, for example, 
Paint.NET, Gimp 

 Microsoft PowerPoint 
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G.2. Panel Icons 

Icons are embedded within a Panel Image to provide semantic context for 
individual I/O points, devices or network nodes. 

G.2.1. Icon Usage 

 siteVIEW panels should utilize standard icon sets, which conform to 
industry standard or de facto meaning. siteVIEW ships with a sample 
set of icons located in the \PanelIcons folder. 

 The recommended format for icons is either PNG or JPG. 

 If siteVIEW will be deployed on a touchscreen, icon sizing must take 
into account human ergonomics to ensure proper selection of 
siteVIEW controls. 

G.2.2. Icon Design Tools 

While there are many tools that can be used to design icon images, the 
following considerations may be useful in the selection of a design tool: 

 Ability to concretely define size, resolution, colors in pixels 

 Ability to generate PNG or JPG files 

Suitable products, shown in order of recommendation are listed: 

 Adobe Photoshop (or Illustrator) or equivalent, for example, 
Paint.NET, Gimp 

 Microsoft PowerPoint 
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G.3. siteVIEW Control Guidelines 

siteVIEW controls are elements that represent I/O points. Controls are 
provided for contact inputs, contact outputs, analog inputs and temperature 
sensors.  

siteVIEW utilizes a subset of the National Instrument Measurement Studio 
control set: http://www.ni.com/mstudio/gallery/start.htm – four basic control 
types are supported: Boolean, Knob, Slide and Display. Each type has 
multiple styles and properties.  

siteVIEW loads a default set of controls and associated properties, upon first 
accessing a TASC device. 

 

 

G.3.1. siteVIEW Control Usage 

 If siteVIEW will be deployed on a touchscreen, sizing must take into 
account human ergonomics to ensure proper selection of siteVIEW 
controls 

 

Figure 143 – Default siteVIEW Controls 

http://www.ni.com/mstudio/gallery/start.htm
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G.3.2. Contact Input Controls 

 Recommended type is Boolean 

 Recommended style is LED. Do not use Toggle, Slide, Rocker or 
Button styles as they may indicate controllable characteristics 

 Recommended color scheme: 

o For OFF status, use non-active color like grey 

o For ON status, use active color like green 

G.3.3. Contact Outputs Controls 

 Recommended type is Boolean 

 Recommended styles are Toggle, Slide, Rocker or Button styles as 
they indicate controllable characteristics. Do not use LED styles. 

 Recommended color scheme: 

o For OFF status, use non-active color like grey 

o For ON status, use active color like green 

G.3.4. Analog Input Controls 

 Recommended type is Knob, Slide or Display. Do not use Boolean. 

G.3.5. Temperature Controls 

 Recommended type is Knob, Slide or Display. Do not use Boolean. 
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G.4. Standard siteVIEW Icon Sets 

 

 

 

Figure 144 – Standard siteVIEW Icon Set 
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APPENDIX H. SITEVIEW ADMINISTRATION 

H.1. siteVIEW Deployment 

As an enterprise solution, a siteVIEW deployment involves multiple steps or 
phases. The following task guideline is provided to properly plan and 
implement a siteVIEW deployment: 

H.1.1. Device Planning 

 Sensor planning – determine what is to be monitored and what 
sensors will be used to provide the monitoring capability. 

 I/O assignment – based on the points to be monitored, use the device 
configuration software (e.g., SCCU) to define and enable the I/O 
layout map, including qualifiers, hold times and threshold ranges.  

 Backhaul communications – determine the method in which the 
device will communicate events to siteVIEW. 

H.1.2. System Communication/Network Design 

 Determine the layout architecture of the various siteVIEW 
components. 

o Location and redundancy of the siteVIEW Data Handler. 

o To determine number and location of siteVIEW 
Communication Services, consider communication load 
balancing for the number of managed devices. 

o Location of siteVIEW Alarm Notification system by considering 
notification mechanisms to be used. 

o Location and number of siteVIEW user interfaces required. 

 Install the various siteVIEW components. 

 Determine siteVIEW interfaces to other IT systems including SMTP 
servers, SNMP managers and backup systems. 

H.1.3. siteVIEW User Interface Design 

 Implement panel design for each device including: 

o Image design and import for background panel. 
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o Naming, location, type and theme selection for each I/O 
control. 

H.1.4. siteVIEW I/O Properties Refinement 

 Select supported sensor settings (e.g., TASC differential sensors, 
TASC BPS sensors). 

 Validate qualifiers, hold times, threshold and local output settings for 
each I/O point to ensure real-world congruency, and, if required, 
validate formula settings and offsets. 

 Determine and configure site-mapping requirements. 

H.1.5. siteVIEW User Account Management 

 Define user accounts and rights. 

 Define groups and user access rights. 

H.1.6. siteVIEW Notification and Alarming Definition 

 Use Global Notification Settings to define mechanisms to be used for 
notification. 

 Use Alarm Settings to define alarms, configure the related notification 
methods and users to be notified. 

H.1.7. siteVIEW Communication Optimization 

 Determine and configure polling strategy. 

 Review system communications and mitigate communication retries 
by adjusting packet timeouts. 

 Review communications load to determine if thresholds need to be 
adjusted or if devices should be balanced amongst Communication 
Service servers. 

H.1.8. Operational Preparedness 

 Review logging infrastructure and resultant files.  

o For cases where the frequency of I/O and alarm history is 
high, further refine qualifiers, hold times and threshold to 
decrease the I/O and alarm events. 

o If there is sufficient data, exporting to Excel or other analysis 
tool may provide insight into system tuning or trends. 

 Using device configuration software (e.g., SCCU), create backups of 
the device’s system. 
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 Export siteVIEW panels for reuse and/or recovery. (Panel export files 
maybe preferential for managing and tracking user interface changes 
where the rest of the system siteVIEW configuration is static.) 

 Determine and configure system database scheduled archiving 
strategy. Define backup and recovery strategy, including off-site 
backups. 

 Confirm operational readiness: 

o Confirm integration with other IT components. 

o Power stability (e.g., UPS). 

o Network stability and redundancy. 

o Consider managing all shutdowns, including shutting of 
operating system updates.  

o Create Windows restore points or system ghost copies in case 
of catastrophic failure. 

 User and administrative training. 

 


